This document provides instructions for installation, configuration, administration, and maintenance of an OpenLAB CDS Workstation. It includes information on the license generation with SubscribeNet.

Table 1  Terms and abbreviations used in this document

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Panel</td>
<td>Control Panel for Agilent OpenLAB software</td>
</tr>
<tr>
<td>Microsoft Control Panel</td>
<td>Part of the Microsoft Windows operating system</td>
</tr>
<tr>
<td>Shared Services</td>
<td>Set of administrative services that control, for example, the security policy and the central configuration of OpenLAB CDS. Shared services are accessed via the Control Panel.</td>
</tr>
</tbody>
</table>
1 Install OpenLAB CDS Workstation
   This chapter describes the installation of the software.

2 Post Installation Tasks
   This chapter describes tasks that are relevant after finishing the installation.

3 Licensing
   This chapter provides basic information on licensing. It describes how you generate a license file with SubscribeNet and install the license in the Control Panel.

4 Configure OpenLAB CDS Workstation
   This chapter describes the initial configuration steps after installing the software. For more details, refer to the Control Panel section in OpenLAB Help & Learning.

5 Optional Procedures
   This chapter describes the installation or upgrade of additional instrument driver software. It also contains information on the installation of OpenLAB Help and Learning only, and on performance improvement on offline machines.

6 About the OpenLAB CDS Software
   This chapter contains an overview of the software architecture and customization options.

7 System Setup and Maintenance
   This chapter contains information on the Control Panel and Shared Services Maintenance. In addition, it describes various maintenance procedures.

8 Uninstall OpenLAB CDS With All of its Components
   This chapter describes the uninstallation of the software.
Contents

1 Install OpenLAB CDS Workstation  7
   Installation Workflow Overview  8
   Before you Begin  9
   Run the OpenLAB Installer  10
   Silent Installation  20
   Install or Upgrade Driver Software  23

2 Post Installation Tasks  25
   Set Account to Enable Automatic Printing  26
   Configure the Antivirus Program  27
   Configure Internet Explorer for OpenLAB Help and Learning  30
   Local Windows Account for Secure Projects Root Folder  30
   Disable Windows 10 Updates  31

3 Licensing  33
   About OpenLAB CDS Licensing  34
   Get a License  36
   Install Your License  40

4 Configure OpenLAB CDS Workstation  43
   Configure Authentication  44
   Configure Security Policy  46
   Configure users, roles, and privileges  47
   Configure the Storage Location  51
   Enable File System Security  52
   Configure Initial Project  52
   Configure Initial Instrument  53
   Other settings in the Control Panel  53

5 Optional Procedures  55
   Install OpenLAB Help and Learning Only  56
   Improve Performance on Offline Machines  57
# Contents

6 About the OpenLAB CDS Software  59
   Software Architecture  60
   Customization  64

7 System Setup and Maintenance  67
   Control Panel  68
   Shared Services Maintenance  73
   Maintenance Procedures  75

8 Uninstall OpenLAB CDS With All of its Components  93
   Uninstall OpenLAB CDS  94
   Uninstall OpenLAB Help and Learning Only  95

9 Appendix  99
   Hardware and Software Requirements  100
   Network Requirements  104
   Operating System Configuration  109
   Instrument Connections  121
   Privileges in the Control Panel  139
   Sales and Support Assistance  147
1
Install OpenLAB CDS Workstation

This chapter describes the installation of the software.
Installation Workflow Overview

**Prepare**
- Run System Configuration Checker from the OpenLAB CDS Installer to ensure that all requirements are met
- Check Appendix for details

**Install**
1. Run Installation wizard, incl. software verification
2. Post Installation:
   - Set Account to Enable Automatic Printing
3. Optional:
   - Improve performance on offline machines

**Get Licenses**
1. Obtain licenses via SubscribeNet
2. Install your license

**Configure**
- Authentication
- Projects, incl. audit trail settings
- Instruments

If you plan scripted installations, see “Silent Installation” on page 20.

See “Install OpenLAB CDS Workstation” on page 7
See “Post Installation Tasks” on page 25
See “Optional Procedures” on page 55

See “Licensing” on page 33

See “Configure OpenLAB CDS Workstation” on page 43.
All configuration tasks are performed in the administrative and management center of OpenLAB, the Control Panel. For more details, refer to the Control Panel section in OpenLAB Help & Learning.
Before you Begin

1 Install all required hardware, including any cables, instrument detectors, and communication cables. GPIB interfaces may be needed for Waters instruments.

2 Run the System Configuration Checker from the OpenLAB CDS Installer to make sure that the PC matches all requirements.
   For details, see “Appendix” on page 99.

3 Update Adobe Reader 11 to the most recent version.
   The OpenLAB CDS installation medium contains the initial version of Adobe Reader 11 (version 11.0.0). To benefit from the latest software improvements, especially related to the software stability, Adobe Reader 11 must be updated to the most recent version (11.x.x).

4 Switch off the Adobe Updater.
   a In Adobe Reader, click Edit > Preferences.
   b On the Updater page, select Do not download or install updates automatically.
      If you need to update Adobe Reader, update it manually when the machine is not busy.

5 If .NET 4.5.2 is not installed on your system, its installation will automatically be triggered by the installation wizard. However, this may require a system reboot. To avoid the system reboot during installation, install .NET 4.5.2 in advance.

6 Prepare an account with administrative privileges to run the installation.

7 If you use Trend Micro™ as an antivirus software, turn off Web Reputation to allow the installation of all components.
1 Install OpenLAB CDS Workstation
Run the OpenLAB Installer

Run the OpenLAB Installer

1 Insert the USB media, right-click the setup.exe file, and run it as administrator. Alternatively, copy the content of the USB media to a network share, and run the setup.exe file from there.

![Image showing the setup process]

**NOTE** If User Account Control (UAC) is switched on, this step requires active confirmation to continue.

2 The OpenLAB Installer checks if the Microsoft .NET Framework 3.5 is available. If it is not, the installer automatically tries to install and activate it.

**NOTE** If .NET 3.5 cannot be enabled, for example, because the computer has no internet access, install .NET 3.5 from the Windows installation media (see Method 3 under https://support.microsoft.com/en-us/kb/2734782). If you do not have installation media, create them as described under http://windows.microsoft.com/en-US/windows-8/create-reset-refresh-media?woldogcb=0.
3 On the start screen, select **OpenLAB CDS**, and click **OK**.

4 Click **Install/Upgrade**.
1 Install OpenLAB CDS Workstation
   Run the OpenLAB Installer

5 The OpenLAB Installer checks if the Microsoft .NET Framework 4.5 is available. If it is not, you will be prompted to install it.

6 License Agreement: Read and confirm Agilent terms and conditions.
7 **Installation Type**: Select **Standalone Workstation**.

8 **Installation Folder**: Provide an installation folder for OpenLAB CDS. Do not use the root folder of any drive.
1 Install OpenLAB CDS Workstation

Run the OpenLAB Installer

9 Select Storage Type: Choose Local File System.
10 Storage Configuration: Provide a folder for storing the project data. Do not use the root folder of any drive.

If you want allow access to the projects root path only from within OpenLAB CDS, select Secure 'Projects Root Path'.
11 **Prerequisite Check**: Mandatory settings in the operating system are checked\(^1\). The report is located in `C:\ProgramData\Agilent\InstallLogs\<date and time>`. Note that `ProgramData` is a hidden folder.

In case of errors, see the following hints:

- Is the name of the installation folder still applicable?
- Is there enough space available on the hard disk? For details, refer to the *OpenLAB CDS Requirements Guide* (*OpenLABCDSRequirements.pdf*).
- Is one of the required ports blocked? For example, if port 80 is blocked by the *World Wide Web Publishing* service, free it by stopping the service.

\(^1\) To run the site preparation tool separately before installing: Start the OpenLAB Installer, select the *Planning* page, and click *System Configuration Checker*. 
12 **Review**: All components that will be installed are listed with their version numbers.

- To save a properties file for a future silent installation (see “Silent Installation” on page 20), click **Save to config File**.
- To start the installation, click **Install**.
1 Install OpenLAB CDS Workstation
Run the OpenLAB Installer

13 Install: After the installation has completed, click Next.

14 Configure: Configuration tools run in the background to configure the local file system. This takes about 10 min. When finished, click Next.
15 Finish:

- To confirm everything has been installed correctly, click **Run Software Verification**.
- To complete the installation, select the **Reboot the computer now** check box, and click **Finish**.

16 In case of errors during the installation: Check the installation log files under C:\ProgramData\Agilent\InstallLogs\[date and time]. Note that ProgramData is a hidden folder.

The installation includes a set of standard instrument drivers. If you need other instrument driver software, install it in a separate step. See “Install or Upgrade Driver Software” on page 23.

---

To start the tool separately at a later point in time, select **Start > Agilent Technologies > Software Verification Tool**.
Silent Installation

OpenLAB CDS supports a command-line mode for installation, also referred to as *silent installation*. This mode supports installation, upgrade, repair, and uninstallation. You can execute silent installations either manually or as part of software management systems such as LANDesk or HP CM.

Export Properties File

The OpenLAB Installer supports a feature to export the installation parameters into a properties file which you can then use for the silent installation.

1. Launch the OpenLAB Installer.
2. Follow the instructions of the wizard.
3. When you have reached the **Review** screen, click **Save to config file**.

Save the file to a suitable location. The file will automatically be saved as a `.properties` file.

You can now use the properties file for the silent installation.
Run Installation

Prerequisites

- You have prepared a properties file for silent installation. See "Export Properties File" on page 20.

- .Net Framework is present on your system.
  If it is not present, it will automatically be installed. You must then manually select Accept to agree with the license agreement.

1 Copy the content of the USB media to a centralized folder.

2 Copy the properties file to the same directory as the CDSInstaller.exe.

3 Right-click the executable of the command prompt or Power shell prompt, and run it as administrator.

4 Navigate to the drive where you have saved the disks.
   For example: C:\CDS_DVD

5 To start the installation, call CDSInstaller.exe with the following syntax:
   
   CDSInstaller.exe -s -c <PropertiesFile>
   
   For example:
   CDSInstaller.exe -s -c Silent.Properties
   
   With this command, you start the OpenLAB Installer without a user interface.

6 Wait about 5 minutes while the installation takes place. To check the process of installation, look at the log files under %ProgramData%\Agilent\InstallLogs.
   
   If a required installable is missing, the OpenLAB Installer will create an entry in a log file, and, depending on the component type, will continue or roll back the installation. An error code will be returned in such scenarios.

7 After the installation has finished, reboot the PC.
Parameters and Return Codes

Parameters

Use the following parameters when calling CDSInstaller.exe in command-line mode:

•  
  Silent mode - no user interface will be shown.

•  
  Configuration file - a properties file contains all parameters.

•  
  <PropertiesFile>
  The properties file contains all required inputs for the installer. Replace <PropertiesFile> with the correct file path and file name. The file must be located in the same directory as the CDSInstaller.exe.

Return Codes

After installation, uninstallation, upgrade, or repair in the command-line mode, the system will return a number code which is explained below.

Table 2  Return codes

<table>
<thead>
<tr>
<th>Error/return code</th>
<th>Return value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success. You can see all of the information in the log file.</td>
<td>0</td>
</tr>
<tr>
<td>Failure. Verify against the log file to see what failed.</td>
<td>any other number</td>
</tr>
</tbody>
</table>

Logging and Tracing

All exceptions, errors and information messages are logged under C:\ProgramData\Agilent\InstallLogs\<date and time>. Note that ProgramData is a hidden folder.
Install or Upgrade Driver Software

The following driver software packages are automatically installed and configured with OpenLAB CDS. For details, see “Instrument Connections” on page 121.

- Agilent GC & GC/MS
- Agilent LC & LC/MS
- Agilent A/D
- Virtual Instruments

Other instrument driver software, add-on software, or upgrades to existing driver software, must be installed and configured manually. Instrument driver software and add-on software can be found on the installation media under Setup\Packages\Add-Ons.

The latest Agilent drivers are available in SubscribeNet. In the Product List, select OpenLAB Software > OpenLAB Agilent Instrument Drivers.

Install or upgrade driver software

1 Run the installer package, and follow the installation wizard.
   For details on the installation or upgrade procedures, refer to the respective driver documentation.

2 Register driver software with OpenLAB CDS.
   See “Register driver software with OpenLAB CDS” on page 24.

The OpenLAB Configuration will find all newly installed or updated instrument drivers and register them with the Shared Services. New instrument types will be available in the Control Panel.
Register driver software with OpenLAB CDS

The following procedure must be carried out after installing drivers other than the ones listed above, and after upgrading any driver. With these steps you make the new drivers available in OpenLAB CDS.

1. In Windows, select **Start > All Programs > Agilent Technologies > OpenLAB Configuration**.
2. In the **OpenLAB Configuration** tool, enter one of the following strings as a server name:
   - The IP address of the workstation, starting with \textit{192.x.x.x}
   - The IP address of the localhost, \textit{127.0.0.1}
   - The computer name
3. Click **Connect** to enable the input boxes for the user credentials.
4. Under **Step 2 - Authentication**, enter your user credentials.
5. Make sure the **Register as Instrument Controller** check box is cleared.
6. Click **Register**.
2

Post Installation Tasks

Set Account to Enable Automatic Printing 26
Configure the Antivirus Program 27
Configure Internet Explorer for OpenLAB Help and Learning 30
Local Windows Account for Secure Projects Root Folder 30
Disable Windows 10 Updates 31

This chapter describes tasks that are relevant after finishing the installation.
Post Installation Tasks

Set Account to Enable Automatic Printing

Set Account to Enable Automatic Printing

OpenLAB CDS allows you to process your data already during the acquisition, without opening Data Analysis. During this automatic processing you can also generate reports and print them to printer or save them as files. Exporting the reports to a network share is a typical way how they are sent to an external system (for example, LIMS).

To access a printer, and also to access a network share, Data Analysis must be started from an account with the required configuration and privileges.

1. Create a domain user or local user with access to the relevant printer and network share.
2. On the Workstation, add the new user to the local Administrators group.
3. Log in as the new user, and configure the relevant printer as this user's default printer.
4. Change the Agilent OpenLAB Instrument Service to run under this user.
   a. In the Windows command line, run services.msc as a user with administrative rights.
   b. In the Services window, right-click the Agilent OpenLAB Instrument Service, and select Properties.
   c. On the Log On tab, select This account, and enter the credentials of the new user.
5. Reboot the PC.
Configure the Antivirus Program

1. Be sure to open the firewall ports listed in the Firewall Settings in the *OpenLAB CDS Requirements* guide.

2. For best performance, consider the following folder exclusions. These folders should only be scanned while the instruments are idle, and no data acquisition or data analysis takes place.
   - [C:\]CDSProjects
   - [C:\]Program Files (x86)\Agilent Technologies
   - [C:\]ProgramData\Agilent
   - [C:\]ProgramData\Agilent IPB Files
   - [C:\]ProgramData\Agilent Technologies
   - [C:\]ProgramData\ChromatographySystem
   - [C:\]ProgramData\Firebird
   - [C:\]ProgramData\IsolatedStorage

Refer to your specific antivirus software documentation on how to configure folder exclusions.
Settings for Trend Micro™ antivirus software

OpenLAB CDS can be used with other antivirus programs as well. If you use Trend Micro™, the following settings are recommended to optimize system performance.

1 **Web Reputation**: Turn off to maximize performance.

   The risk of turning off Web Reputation is that web traffic through browsing from the machine will not be checked.

   Ensure that there is another URL/web scanner on the gateway level to protect the endpoint, or ensure that the endpoints have limited access to Internet. These production machines should not have access to Internet websites where most of the infections are coming from.

2 **Real Time Scan**: Add exclusions, and modify scan direction from **Created/Modified/Retrieved** to **Created/Modified**.

   Exclusions ensure that the working directory of Agilent Technologies will not be scanned, thus improving performance.

   The risk is that only files that are created and changed on this machine are scanned. Files that are just accessed will be bypassed. Dormant Files that got infected without being noticed at the time they were created or written to the machine will not be scanned.

   Increase scheduled scan to daily to ensure all files on the machine are being checked for infections that are dormant or not moving.

3 **Behavior Monitoring**: Add below list of programs to **Approved programs**.

   C:\Program Files (x86)\Agilent Technologies\...
   - OpenLAB Acquisition\Agilent.OpenLAB.Acquisition.AcqInstrumentService.exe
   - OpenLAB Acquisition\Agilent.OpenLAB.AcquisitionClient.exe
   - OpenLAB Data Analysis\Bin\Agilent.Chromatography.DataAnalysis.Processing.ProcessingServer.exe
   - OpenLAB Data Analysis\Bin\Agilent.Chromatography.DataAnalysis.UI.CustomCalculationDesigner.exe
   - OpenLAB Data Analysis\Bin\Agilent.OpenLab.DataAnalysis.exe
   - OpenLAB Data Analysis\Bin\Reporting\Agilent.OpenLab.Reporting.RdlDescriptor.exe
   - OpenLAB Data Analysis\Bin\Reporting\Agilent.OpenLab.Reporting.RdlDescriptorContextMenu.exe
Configure the Antivirus Program

- OpenLAB Data Analysis\Bin\Reporting\IntelligentReporting.RenderServiceHost.exe
- OpenLAB Data Analysis\Bin\Reporting\TemplateDocumentation.exe
- OpenLAB Services\Automation\AutomationServerHost.exe
- OpenLAB Services\Diagnostics\DiagnosticsToolsServiceHost.exe
- OpenLAB Services\Licensing\Flexera\lmadmin.exe
- OpenLAB Services\Licensing\Licensing.Service.Host.exe
- OpenLAB Services\Server\SharedServicesHost.exe
- OpenLAB Services\UI\Agilent.OpenLab.ControlPanel.exe

The risk is that if any of the excluded files get infected, it will not be detected. For example, trigger a schedule on a daily basis to cover these files.

4 Realtime monitoring: Add below folder to the exclusion list of Realtime Monitoring setting:

C:\Program Files (x86)\Agilent Technologies\
Post Installation Tasks
Configure Internet Explorer for OpenLAB Help and Learning

Configure Internet Explorer for OpenLAB Help and Learning

If you use Google Chrome, no further settings are required.

If you use Internet Explorer as your default browser: Make the following settings to ensure that OpenLAB Help and Learning is opened without showing a confirmation prompt.

1. In Internet Explorer, click **Tools > Internet Options**.
2. Select the **Advanced** tab.
3. Under **Security**, select **Allow active content to run in files on My Computer**.
4. Confirm your settings.
5. Reboot the computer to make the settings effective.

Local Windows Account for Secure Projects Root Folder

If you installed OpenLAB CDS using the **Secure 'Projects Root Path'** option, the local Windows user **AgtSfsUser** and the local Windows group **AgtSfsGroup** have been created during installation.

To ensure that the system is working properly:

- Do not delete this group and account, and
- Do not disable Windows logins for local accounts.
Enable Windows 10 Updates

Your company's security policy may require that Windows updates not be automatically applied. Updates may need to be tested first, and then be distributed internally.

With Windows 10, automatic updates cannot be turned off in the Windows settings as in earlier Windows versions. Instead, you must disable the Windows Update service. As this service is required during installation, you can only disable it after finishing the installation.

1. In the Start menu, search for services.msc and press Enter to open the Services window.

2. Double-click the Windows Update service.

3. Set the startup type to Disabled.

**NOTE**
The computer will not be automatically updated anymore. Make sure you keep the computer up to date by other means.
2 Post Installation Tasks
Disable Windows 10 Updates
This chapter provides basic information on licensing. It describes how you generate a license file with SubscribeNet and install the license in the Control Panel.
About OpenLAB CDS Licensing

Software subscriptions and Software Maintenance Agreement (SMA)

Bundled into OpenLAB CDS is a one-year software subscription which provides access via SubscribeNet to new software updates, product upgrades, familiarization and media.

As a best practice, we recommend customers renew subscriptions annually so as to maintain their licenses and have full access to the newest updates, upgrades, media and familiarization. To manage software entitlements, order media or download software, log in to SubscribeNet by pasting this link in your browser: http://agilent.subscribenet.com/

Software subscriptions do not include installation services. Installation or upgrade services must be purchased by contacting your sales representative in your region.

License Types

There is a 60-day Startup License for the system. The expiration period starts with the first launch of an application. In order to run the data system software after that period, you must install your final license file.

OpenLAB CDS licensing requirements for system components are satisfied in three ways:

1. Core license – this is the final product license that you must install to your system within the 60-day trial period to continue use. The core license is installed to the license server – the OpenLAB CDS Workstation PC, or the server to which OpenLAB CDS was installed in a client/server system.

2. Shared licenses – system computers and other components can have shared, or add-on, licenses – because they share a core license.

3. Counted licenses – these licenses are part of the OpenLAB CDS floating licensing strategy. They are not permanently assigned to any one component. Instead they are automatically assigned to components, such as
AICs and instruments, while the components are starting up. The licenses are automatically returned when the component is closed. The license management program controls license issuance and retrieval.

In this case, the only requirement is that a component is licensed while running. You only need enough licenses for all components running concurrently, rather than for each installed component.

**License File**

A license file will contain your software license. This file is installed on the workstation. The license file is bound to this computer, and cannot be moved to another workstation without regenerating the license in SubscribeNet.

Information in the license file defines the number of instruments and other options that may be used concurrently with your system.

The most efficient way to manage and maintain your licensing is through the Internet. To generate, download, and install a final license for your product, you will need:

- The authorization code label provided in the lavender envelope containing your Software Entitlement Certificate.
- The URL for SubscribeNet from the Software Entitlement Certificate.

If you have not received a lavender envelope for your product, contact your vendor or internal support.
Get a License

Obtain a License with SubscribeNet

If you have Internet access, use the following procedure to generate and
download your license for your OpenLAB CDS system.

If you do not have Internet access, skip to the section “Other Ways to Obtain a
License” on page 38.

If you are a new user who has not registered with SubscribeNet, continue with
the section New Users.

If you have registered with SubscribeNet, skip to the section Users registered
with SubscribeNet.

New Users

1 From a computer with Internet access, enter the URL provided in the
Software Entitlement Certificate in an Internet browser.

2 At the bottom of the login page, click click here to register.

3 On the registration page, enter the authorization code from the label and
complete the profile information (required fields are marked with an
asterisk *).

The email address you enter will become your login ID.

4 Click Submit. The system will generate and display an account name for you.

SubscribeNet will send a welcome email with your login ID and password.

5 Log in to SubscribeNet using your login ID and password.

Once you log in, you can use the online user manual link for help with any
questions you have.

6 Select Generate or View licenses from the left navigation bar.

7 Follow the prompts to generate your new license.

You will be prompted for the HOST NAME of the computer. The host name
you enter must match with the network name of the computer where the
Control Panel is running. Do not include any DNS suffix (domain.com)
references in the entered machine name.
During this process you will have to enter the MAC address of your license server. For workstations, this is the local computer. For client/server systems, this is the server.

To retrieve your MAC address from a computer where OpenLAB CDS is already installed, open the Control Panel and browse to the Administration > Licenses section. Use the Copy MAC Address or Save MAC Address function to obtain the MAC address for license generation.

If any changes are made to the computer name or domain reference after the license is installed, remove the license. A new license will need to be created in SubscribeNet, downloaded, and installed.

If the network adapter that provides the MAC address used during license creation is removed from the machine, your license will no longer be valid. A new license will need to be generated with a currently available MAC on the license server.

8 When the system generated the license, view its details, then click Download License File. Save the license file to your computer and to a backup location (such as a portable storage device).

Use your login ID and password when you revisit the Agilent SubscribeNet site to regenerate a license file, add new authorization codes, or further configure the license for your system.

Users registered with SubscribeNet
1 Login to SubscribeNet with your e-mail address and password.
2 Select the SubscribeNet account associated with this authorization code, if you have more than one account.
3 From the SubscribeNet navigation pane, select Register Authorization Code.
   This will allow you to enter your new authorization code and make available the new license entitlements
4 Follow steps 7 through 9 in the previous procedure, New Users, to generate or view your new licenses.
Other Ways to Obtain a License

If you are unable to generate a license, contact your nearest Agilent technical support office. A representative will tell you how to submit an OpenLAB CDS License Generation Form in your location.

Offline Licensing

If an internet connection is not available in your laboratory:

You or your local on-site service engineer will collect the necessary information from you to allow Agilent to create a license account on your behalf. For phone support in your region, call the sales and service number for your region. See the Appendix for a list of numbers for various countries.

Required Customer Information for Agilent License Support:

The following information must be provided to Agilent in order to enable us to create a licensing account on your behalf.

1 Collect Account Information:

   Your account name will be your company name and Lab name separated by a comma. Employee information provided here will be used to define the first administrator of your account for future access to the system as required. Please prepare the following pieces of information prior to contacting your local Agilent sales and service center in order to expedite service:

   • Company Name
   • Lab/Department Name
   • First Name
   • Last Name
   • E-mail address
   • Job Title
   • Phone #
   • Address, City, State/Province, Postal Code, Country

2 Collect Authorization Code(s):

   The authorization code is an alpha-numeric code provided on a label which is enclosed in a lavender envelope. If you have received more than one code
you must provide all codes to ensure that all ordered licenses are granted to your account.

3 Receiving your license:

Once the above information is provided Agilent will then work on your behalf to generate a license file through SubscribeNet. The license file will either be sent to your shipping address (on a CD), or your local FSE will deliver it in person (usually on USB media). Once your license is received follow the below section on “Installing your License” to finish installing your license on your CDS system(s).

**Request a license by FAX**

If you do not have Internet access or an FSE on-site, you can fax your license request as follows:

1 Complete the OpenLAB CDS License Generation Form (P/N: M8301-90071) with:
   - Email address
   - Authorization code
   - User profile information (including exact computer name and MAC address)

2 Fax the form to your local Agilent Sales and Service Center. You will receive a reply FAX with your new account name, login ID, and password. The system will also send this information to you via email.

3 Add the license file to your system.
Install Your License

The license must be added to your system using the Control Panel.

1. Start the Control Panel shortcut on the desktop or go to Start > All Programs > Agilent Technologies > OpenLAB Shared Services > Control Panel.

2. Navigate to Administration > Licenses.

3. In the ribbon, click Add License.

4. Choose to install the license by:
   - Using the license file option to browse to and open the license file (.lic) saved from the license generation process in SubscribeNet.
   - Selecting the License Text option and copying the license text from a text file received into the provided field.

5. Click OK.

The Administration interface in the Control Panel will now display the status of installed licenses.
**Update or replace a license**

If you have purchased new options, such as additional instrument controls or client license, your license must be regenerated in SubscribeNet (see “Licensing” on page 33) and must be re-applied to the system.

1. Start the Control Panel from any machine connected to the system you want to install the license for.
2. Navigate to *Administration > Licenses*.
3. In the ribbon, click *Remove License*.
4. In the ribbon, click *Add License*.
5. Browse to and open the license file saved from the license generation process in SubscribeNet.
6. Restart the following Windows services:
   - *Agilent OpenLAB License Server*
   - *Agilent OpenLAB Licensing Support*

If you work in an OpenLAB CDS Client/Server system, restart the services on the server.
3 Licensing
Install Your License
4

Configure OpenLAB CDS Workstation

Configure Authentication 44
Configure Security Policy 46
Configure users, roles, and privileges 47
  Create or import users 47
  Groups 48
  Roles and Privileges 48
  Add users or groups to a role 50
  Specific Roles for Individual Instruments or Projects 50
Configure the Storage Location 51
Enable File System Security 52
Configure Initial Project 52
Configure Initial Instrument 53
Other settings in the Control Panel 53

This chapter describes the initial configuration steps after installing the software. For more details, refer to the Control Panel section in OpenLAB Help & Learning.
Configure Authentication

OpenLAB CDS supports the following authentication providers:

* **None** (default setting after installation)
  In this mode, no login screen is shown when you access the Control Panel. The user is automatically logged in to the application with security disabled. All log entries record the user as "Anonymous". With the authentication provider **None**, the Security Policy and User Management nodes are unavailable in the Control Panel.

* **Internal**
  In this mode, the user's credentials are stored in the OpenLAB CDS system. You are asked to create an administrator account for OpenLAB CDS before setting up other users. This is the only mode in which you can create new users within the system; in all other modes you can only map to users that exist in a different system.

* **Windows Domain**
  You import existing Windows users into OpenLAB CDS system. The authentication is done either by Windows Active Directory domain or NT 4.0 Domain within the Enterprise. OpenLAB CDS only uses the identity and password of the mapped users; roles and privileges for OpenLAB CDS are still configured in the Control Panel.

1. Launch the Control Panel.
2. Navigate to **Administration**.
3. In the navigation pane, select **System Configuration**.
4. In the ribbon, click **Edit System Settings**.  

**NOTE**
With the authentication provider **None**, any activity logs will display a generic **System** operator with no additional identification. This is not recommended for compliant setups.
5. Select the required authentication provider from the drop-down list, then click **Next**.

**NOTE**
Do not change the storage type.

6. Provide user credentials:
   a. For **Windows Domain**: Select the check box to use a domain user, and provide user credentials with the rights to obtain user and group information. Then click **Select Account** to open the **Search Users** dialog and select an administrator account.
   b. For **Internal**: Click **Create Account** to create a new administrator account for OpenLAB CDS.

7. Confirm your settings. When complete, the Control Panel will restart.
Configure Security Policy

If you need to comply with specific standards, adjust the security policy as required.

With the authentication provider **Internal**, you can set all parameters in the Control Panel. With an external authentication provider (Windows Domain), you can only set the inactivity time in the Control Panel; all other parameters are defined by the external system.

1. Launch the Control Panel and navigate to **Administration**.
2. In the navigation pane, select **Security Policy**.
3. In the ribbon, click **Edit Security Policy**.
Configure users, roles, and privileges

With internal authentication, you create the required users in the Control Panel. With Windows domain as an external authentication system, you import the Windows domain users.

To define what users are allowed to view or do, OpenLAB CDS offers predefined roles and allows you to define your own specific roles. Roles are equipped with numerous specific privileges.

Each user can be member of multiple groups. You must assign one or more specific roles to each group. You can also assign roles to single users; however, for the sake of clarity, it is strongly recommended to assign roles only on the group level. Every member of a group automatically has all roles of this group.

1. Launch the Control Panel and navigate to Administration.
2. In the navigation pane, select Users, Groups, or Roles.
3. Create new items, or edit the existing ones.

Create or import users

Use the Control Panel to manage the roles and privileges. You can create custom roles, or assign one or more of the predefined roles to give users varying degrees access.

Add users (Internal Authentication only)

1. From the navigation pane, click Administration > Users.
2. In the ribbon, click Create User.
3. In the Create User dialog, provide the relevant parameters:
   - Enter the name and password for the new user.
   - By default, the new user will need to change the password at next logon. If this is not required, clear the User must change password at next logon check box.
   - In the Role Membership tab, assign the user to an appropriate role. You can use the default roles, or prepare your own roles in the Control Panel under Administration > Roles.
4. Click OK.
Import users (Windows Domain Authentication only)

To add users to your system, you must have privileges to obtain user and group information from the domain.

1. From the navigation pane, click **Administration > Users**.
2. In the ribbon, click **Import**.
3. In the **Search Users** dialog box, enter search string for the Windows domain username.
4. From the **Search Results** list, select the user you want to import, and click **Add**. The user is added to the **Selected Users** list.
5. Repeat steps 2 through 4 until you have added all the user names that you want to import to the **Selected Users** list, then click **OK**.

Groups

If you use an external authentication provider, you can either import the names of groups that exist in the external system, or create new internal groups. There is no limit on the number of groups that can be mapped or created.

Assign users to groups either in the external system or in the Control Panel. If you need additional user assignments that are relevant only for OpenLAB CDS, create them in the Control Panel. Otherwise it is sufficient to only import the groups and assign the required roles to the groups.

If you delete or unmap a group, the users who were members in this group remain unchanged.

Roles and Privileges

Roles are used to assign privileges to a user or a user group globally or for a specific instrument or location. The system contains a list of predefined roles which are installed as part of the system installation (for example, **Instrument Administrator**, **Instrument User**, or **Everything**). Each role has certain privileges assigned.
Privileges are grouped according to the three main role types (Project role, Instrument role, and Administrative role). When you assign privileges to a role, you first select the required role type and then select the privileges related to this role type. Each role can only have privileges of one specific role type; the only exception is the predefined role **Everything**, which has all privileges of all role types. Users or groups may require multiple roles to perform system functions. For example, a user with the role **Chemist** may need another role such as **Instrument User** with the privilege to run an instrument.

You can create a tree of different locations in the Control Panel, and add instruments to the relevant locations. For each instrument or instrument group, you can assign different Instrument roles (see also “Specific Roles for Individual Instruments or Projects” on page 50). For example, a user can have the role **Instrument Administrator** for one instrument, and **Instrument User** for another instrument.

You can also create a tree of different projects or project groups in the Control Panel, and assign different Project roles for different projects (see also “Specific Roles for Individual Instruments or Projects” on page 50). For example, a user can have the role **Project Administrator** in one project, so that he can manage the settings in the Control Panel. In a second project, he may have a role that allows him to edit the content of a project, but not to change the project settings.

**Table 3** Description of role types

<table>
<thead>
<tr>
<th>Role Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative privileges</td>
<td>These privileges are globally assigned to a user or group and cannot be changed on the instrument/location level. They are the typical administration privileges such as <strong>Backup and restore, Manage security, Manage printers</strong> etc.</td>
</tr>
<tr>
<td>Instrument privileges</td>
<td>These privileges can be assigned globally or on the instrument/location level. Privileges for instruments are, for example, <strong>View instrument or location</strong> and <strong>Run instrument</strong>. Users need the <strong>View instrument or location</strong> privilege on the global level to see the locations and instruments tree in the Control Panel.</td>
</tr>
<tr>
<td>Project privileges</td>
<td>Privileges for accessing or modifying different levels of data. You can assign these privileges globally or on project level.</td>
</tr>
</tbody>
</table>

For more information on privileges, see the Appendix.
Add users or groups to a role

1. From the navigation pane, click Administration > Roles.
2. In the Roles window, select the role you want to assign to users or groups.
3. In the ribbon, click Edit Role.
4. In the Edit Role dialog box, click the Members tab.
5. Click Add user or group.
6. In the Search Users and Groups dialog box, enter the name of a user or group, and click Search to view a list of all users and groups that meet the search criteria.
7. Under Search Results, select a user or group, and click Add.
8. Click OK.

Specific Roles for Individual Instruments or Projects

By default, the roles of users or groups are globally set for all locations, instruments, project groups, or projects. The role settings are inherited from the root node Instruments or Projects respectively. In order to assign a different role to a user or group for one specific node, you can deselect the Inherit privileges from parent check box in the Edit Privileges dialog for the required node. Afterwards, you can assign a different role that will be valid only for the specific node.

You can assign Instrument roles to individual locations or instruments.

If you use projects, you can assign Project roles to individual project groups or projects.

Administrative roles are always set globally.
Configure the Storage Location

All project data is stored on the local file system. Each project has its own project folder, but all project folders are located in the Projects Root Path. The following procedure explains how to change Projects Root Path.

**Prerequisites**
To be able to change the Projects Root Path, the directory must be empty. You did not yet create any projects.

**NOTE**
If you already created projects, move the data away temporarily, then delete the project. After you have set the correct path, create the projects again and move the data back.

1. Launch the Control Panel.
2. Navigate to Administration.
3. In the navigation pane, select System Configuration.
4. In the ribbon, click Edit System Settings.
5. Select the storage location File System from the drop-down list, then click Next.
6. Provide the new Projects Root Path.
7. Confirm your settings. When complete, the Control Panel will restart.
Enable File System Security

With File System Security, you prevent users from modifying OpenLAB files outside OpenLAB CDS. File System Security may have been enabled already during installation, but you can enable it at any time. File System Security is optional.

1. Launch the Control Panel.
2. Navigate to Administration.
3. In the navigation pane, select System Configuration.
4. In the ribbon, click Edit System Settings.
5. Select the storage location File System from the drop-down list, then click Next.
6. Select the Secure project folder check box, then click Next.
7. Confirm your settings.

Configure Initial Project

1. Launch the Control Panel and navigate to Projects.
2. Create and configure a project:
   On the CDS Settings tab:
   - Enter the locations for Methods, Sequences, Results, Sequence Templates and Report Templates. As the project will be stored in a database, these paths do not refer to the local files system but are relative to the project's parent node.
   - Consider the required audit trail settings for this project.

For more details, refer to the Control Panel section in OpenLAB Help & Learning.
Configure Initial Instrument

1. Launch the Control Panel and navigate to Instruments.
2. Click Create in the ribbon to create a new instrument.
3. Select the new instrument, and click Configure Instrument in the ribbon.
4. It is recommended that you use Auto Configuration to configure your instruments: Select a module, click Auto Configuration, and provide the instrument's IP address or hostname.

For more details, refer to the Control Panel section in OpenLAB Help & Learning.

Other settings in the Control Panel

Consider also other settings in the Control Panel, such as:
- changing the instrument status reporting frequency, or
- changing audit trail settings for a project,
- editing signature levels for a project (only accessible from an OpenLAB CDS Workstation or Client).

For more details, refer to the Control Panel section in OpenLAB Help & Learning.
4 Configure OpenLAB CDS Workstation
Other settings in the Control Panel
This chapter describes the installation or upgrade of additional instrument driver software. It also contains information on the installation of OpenLAB Help and Learning only, and on performance improvement on offline machines.
5 Optional Procedures
Install OpenLAB Help and Learning Only

Install OpenLAB Help and Learning Only

Use this option to install OpenLAB Help and Learning content without installing OpenLAB CDS applications.

Do not use this option on a machine where OpenLAB CDS is, or will be, installed.

1 Insert the USB media, right-click the setup.exe file, and run it as administrator.

2 On the start screen, select OpenLAB CDS, and click OK.

3 In the OpenLAB CDS Installer, click Documentation.

4 Click Install OpenLAB Help and Learning Only.

5 Select your language, and click Next.

6 On the welcome screen, click Next.

7 Confirm Agilent terms and conditions, and click Next.

8 Review the installation directory. If desired, click Change... to specify a different directory.

9 Click Install.

10 When the installation is complete, click Finish.

11 If you plan to use Internet Explorer to view the content, set the Internet Options as described under “Configure Internet Explorer for OpenLAB Help and Learning” on page 30.

Without these settings, you will need to click Allow blocked content when opening the help.

No settings are required for Google Chrome.

You can uninstall or repair OpenLAB Help and Learning from the same link in the installer (see “Uninstall OpenLAB Help and Learning Only” on page 95).
Improve Performance on Offline Machines

Computers running OpenLAB CDS may exhibit slow performance when they are not connected to the Internet.

The windows operating system has routines built into its operation that causes it to continuously search for an online connection in order to update to all the latest Windows security certificates when using secure software.

Use the following system settings on all workstations to remedy this problem.

1. Open Internet Explorer and select **Tools > Internet Options**. In the **Advanced** tab, clear the following check boxes:
   - **Security > Check for publisher’s certificate revocation**
   - **Security > Check for server certificate revocation**

2. Change the following registry keys:
   - `[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\SystemCertificates\AuthRoot]`
     "DisableRootAutoUpdate"=dword:00000001
   - `[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Policies\Microsoft\SystemCertificates\AuthRoot]`
     "DisableRootAutoUpdate"=dword:00000001

3. Document that you turned off the Root Certificates, as this can prevent users from installing other applications.
5 Optional Procedures

Improve Performance on Offline Machines
6 About the OpenLAB CDS Software

Software Architecture 60
Local File System 63
Customization 64
  Customization via custom calculations 64
  Customization via report templates 64
  Customize application to start external programs 65

This chapter contains an overview of the software architecture and customization options.
Software Architecture

OpenLAB CDS is a data system solution for analytical workflows that controls a wide variety of instruments including the industry-leading GC and GC/MS-SQ instruments, along with best-in-class LC and LC/MS-SQ. By combining chromatography and single-quad mass spectrometry into a single scalable solution with centralized system administration, you can streamline your laboratory workflows and maximize productivity. A tailored and simplified user interface with a new state-of-the-art user experience, along with e-learning tools, to help you to get up to speed and productive as fast as possible.

The Agilent OpenLAB CDS software is provided on read-only USB media that contain all required installables and documents. This includes:

- Acquisition
- Data Analysis and Reporting
- Shared Services
- Content Management
- Custom Calculation Editor
- Help and Learning Platform
- User documentation
- Instrument driver software for Agilent LC, GC, LC/MS, GC/MS, or A/D
- Instrument driver software for virtual instruments (Data Player)
- Agilent Parts Finder
- Third party tools
**Workstation**: All components on a single PC; results are stored in the local file system; the system supports up to four instrument connections.
### Software Architecture

**Workstation Plus (with Content Management):** All components on a single PC; results are stored in a database provided by the Content Management component; Users have no access to the data via the local file system; supports up to four instrument connections.

![Workstation Plus Diagram](image)

**Figure 2** Components on a Workstation Plus
Local File System

All project data such as methods, raw data, results, templates, or reports are stored in the local file system. Each project has its own folder. All project folders are located in one specific *Projects Root Folder*.

By default, the content of the Projects Root Folder is not protected against modification or deletion from local file browsers. To ensure data integrity, select *Secure project folder* during installation, or select *Secure project folder* in the system settings of a ready installed Workstation.

When the project folder is secured, normal windows file operations are restricted to only members of the *AgtSfsGroup* user group.
Customization

OpenLAB CDS can be customized to support various workflows and applications. Customizing capabilities are available via different approaches.

For more information on how to use custom calculations and report templates, refer to OpenLAB Help & Learning.

**Customization via custom calculations**

Data Analysis can be enriched by calculating additional values. The calculations are done with the Custom Calculator Designer and referenced by or embedded in a processing method.

These calculations can be quite complex. The calculation results are directly visible in Data Analysis, no report generation is needed.

Custom calculations are processed on result set level. They are only computed if all injections of the result set are processed together.

**Customization via report templates**

In a report template you can call calculation results from a method-specific custom calculation, or define additional, template-specific calculation expressions. The template-specific values are only visible in the report preview or the final report.

Reports are generated on either injection level, result set level, or across multiple result sets. Reports can be used for automated result evaluation on all the mentioned levels.

Example report templates for typical petrochemical or pharmaceutical applications are provided with the application and can be imported in Data Analysis (see *Import default templates* in OpenLAB Help & Learning).
Customize application to start external programs

The customization capabilities allow to add ribbon groups and icons in the Data Selection and Data Processing views of OpenLAB Data Analysis.

It is possible to start an external program via an icon and to hand over the project data path and the path of the current injection as parameters to the program.

The customization is based on a file CustomToolsConfiguration.xml at C:\ProgramData\AgilentTechnologies\OpenLAB DataAnalysis\ that needs to be created by the user. An example CustomToolsConfiguration.xml file is included on the media at Setup > Tools > UCL > Support > UCL > Customization folder.

For more information, refer to OpenLAB Help & Learning.
About the OpenLAB CDS Software

Customization
This chapter contains information on the Control Panel and Shared Services Maintenance. In addition, it describes various maintenance procedures.
Control Panel

Using the Control Panel, you can access Shared Services control features such as security policy, central configuration, or lab status at a glance.

Instrument Management / Lab Status at a Glance

The Instruments view in the Control Panel offers an overview of all instruments in the network or on the workstation. You can see the following information for all instruments, summarized on one page:

- Status of the instrument with related color code
- Instrument name
- Instrument location
- Instrument type
- Last change of configuration

Depending on the configuration, this information may be accessed from a single workstation PC or from multiple clients in a network.

You can create a tree of different locations in the Control Panel, and add instruments to these locations. Using locations, you can organize your instruments for example by department, by laboratory, or by lab bench. For each instrument, you can provide basic information such as the name, description, and instrument type.

Depending on your privileges in OpenLAB CDS, you can perform several operations on the instruments:

- View instrument information (instrument status, instrument details, activity log)
- View the locations and instruments tree
- Edit the instrument information
- Configure the instrument

The instrument configuration is stored in the Shared Services database. You access the configuration tool from the Control Panel.
• Launch the instrument
  
  On a Workstation, you can only launch instruments that are configured on this PC.
  
  With a Client/Server system, you can launch instruments remotely from any OpenLAB CDS client in the network.

Your privileges can differ for the different locations and instruments (see “Specific Roles for Individual Instruments or Projects” on page 50).

License Management

This service includes the administration of all licenses that are required for your system.

Before adding a license file, you must first purchase the license and generate the license file using SubscribeNet. For more information on generating new license files, see “Obtain a License with SubscribeNet” on page 36.

License Management in the Control Panel provides the following functions:

• You can add license files to the license server.
• You can navigate to the license monitor and view the properties of all licenses installed on a given license server.
• You can remove license files from the license server. This may be useful if an invalid license file has been added.
• You can view or change the license server.
• You can view, copy, or save the MAC Address of the license server.
• You can navigate to the Agilent Electronic Software and License Delivery web page to obtain a license.
The following properties are shown for installed licenses:

- **Feature**: This indicates the type of license used.
- **Version**: If a license is versioned, you can see the version number. For licenses that are not versioned, the version is always shown as 1.0.
- **In Use (Available)**: This indicates the number of licenses that are currently in use and, in brackets, the total number of licenses. With the OpenLAB CDS licensing strategy, a license is only in use as long as a software instance is running (see “License Types” on page 34).
- **Expiration**: If the license is only valid for a certain period of time, the expiration date is displayed.

In the Alerts pane, you are informed if the number of available licenses has gone down to zero for a specific feature, or if you have started a software instance which requires a license that is unavailable.

For more information on adding license files and viewing the license properties, refer to the Control Panel section in OpenLAB Help & Learning.

**System Activity Log**

The System Activity Log allows you to centrally access all system activities. It contains information on the various events associated with Shared Services or with specific instruments. You can filter the list in order to view only events of a specific type, in a specific time range, created by a specific user, or containing a specific description.

The following types of events are recorded:

- System
- Instrument Management
- Instrument
- Project Management
- Instrument Controller
- User
- Group
- Security
- Printer
- License
The messages can come from other components, such as the user management, or from an instrument module. Instrument messages include error messages, system messages, or event messages. The System Activity Log records these events irrespective of whether you have been alerted to them or not. To get more information on an event, expand the line of interest in the activity logbook viewer.

**Diagnostics**

The **Diagnostics** view allows you to access several reports and tools for diagnostic purposes:

- Ping the server.
- Create a report, either for the local system or for the server, with information on the operation system, processors, disk drives, processes, network, and connections.
- Centrally access and download all the log files, trace files, etc. that are created by the registered modules.

**Administrative Reports**

In the **Administrative Reports** view, you can additionally create and export various XML or PDF reports related to the system configuration:

**Instrument Controllers Report**

Detailed information of all Instrument Controllers. When this report is generated on a Workstation, the information presented relates to the local system. When this report is generated on a client-server system, all Instrument Controllers are included.

**Instruments Report**

Provides detailed information about configuration and access privileges for all instruments on the system. On client-server systems, this report includes all instruments on all Instrument Controllers.
Projects Report

Provides detailed information about configuration and access privileges for all projects on the system.

Roles and Privileges Report

Describes all roles defined on the system, including details of all privileges included in each role.

System Report

This report provides a consolidated view of the system, which includes all information about instrument controllers, instruments, projects, roles, users, and groups.

User's and Group's Role Assignment Report

This report provides an overview of all users and groups with their assigned roles.

Authentication Provider

The authentication provider is described under Configure an OpenLAB CDS File System Workstation. For details, see “Configure Authentication” on page 44.

Security Policy

The security policy is described under Configure OpenLAB CDS. For details, see “Configure Security Policy” on page 46.

User Management

The user management is described under Configure OpenLAB CDS. For details, see “Configure users, roles, and privileges” on page 47.
Shared Services Maintenance

The **Shared Services Maintenance** program is automatically installed with your OpenLAB software to help administrators manage the system.

To open the utility, select **Start > All Apps > Agilent Technologies > OpenLAB Shared Services > Shared Services Maintenance**. A user must have Windows administrator rights to access this utility.

**Windows Domain tab**
In this utility, the **Windows Domain** tab is relevant if you use windows domain authentication to identify your OpenLAB users.

OpenLAB CDS must be given access to the server where these credentials are stored. In the **Windows Domain** tab, you specify or change the credentials that OpenLAB CDS will use to access your windows domain server.

For client/server systems: This feature can only access credentials that are stored on the computer where you launched the **Shared Services Maintenance** program. To specify or change the **Domain**, **User name**, or **Password** for the windows account that will be used to access your windows domain server, use the **Shared Services Maintenance** program that is installed on the server.

**Server Settings tab**
The **Server Settings** tab can be used to manage different server connections. In a workstation configuration, there is typically only the connection to the local machine.

**Activity Log Export tab**
Activity log databases can become large over time and affect performance of activity log related operations. Use the **Export** and **Purge** functions on the **Activity Log Export** tab to export the activity log entries to an XML file and purge them from the Activity Log database.

**Backup and Restore tab**
The Shared Services database contains information that is accessed by the Control Panel (such as users, roles, permissions, projects, instruments etc.). In order to simplify backup and restore tasks for the Shared Services database, the **Backup and Restore** tab provides a simple interface for performing these tasks.

---

1 In Windows 7 or 8.1: **Start > All Programs > Agilent Technologies > OpenLAB Shared Services > Shared Services Maintenance**
To perform a backup:

1. Specify the backup directory and retention time.
   The retention time is used to delete any files older than specified.

2. Click **Backup**.
   The backup is placed in the specified backup directory. Backups older than
   the retention time are deleted.

**NOTE**

The tool automatically generates filenames for the backup files. Never change these
filenames, as the tool relies on a specific naming convention.

To restore to the selected backup in the list:

1. Verify that all connections to the system are shut down before performing a restore.

2. Select the backup that you want to restore, then click **Backup**.
Introduction

Disaster Recovery Planning

Prepare a recovery plan for the unlikely case of OpenLAB CDS becoming inoperable due to a hardware or software failure. This plan must include information and procedures for completely restoring the operating system, the software, and data. Make sure that the disaster recovery plan has been tested and confirmed to be working.

The Disaster Recovery Plan must include the following:

• Hardware information: CPU, Memory, and Hard disk configuration information.

• Computer identity: Name, IP, domain, URI, etc.
  • Computer administrator information: username and passwords for logging in to the server

• Software information: OS version, Patch level.

• Installation parameters:
  • Installation folder
  • Project folder
  • Installation log files
  • Shared Services language

• Installed licenses

• Registered applications

• 3rd party software information: applications and their revisions and install paths.

• Backup procedures (see “Software backup procedure” on page 77, “Data Backup Procedure” on page 83)

• Backup media location and organization details.

• Restore procedures (see “Software Restore Procedure” on page 86, “Data Recovery Procedure” on page 88)
Backup and Restore Procedure Overview

The backup procedure for an OpenLAB CDS Workstation with local file system includes all software and data. It describes how to create an image of the current system on a portable USB hard drive and a Windows system repair disc. The USB drive and repair disc are used together to restore your system to the original state, if needed.

It is mandatory that every workstation is backed up regularly. Periodic full backups and differential backups between the full backups must be created by administrators. These backups are the only way to restore a system in the event of a hardware or software failure. It is also mandatory that a disaster recovery plan and restore procedures are tested to confirm that the backups are sufficient to restore your system.

The data backup procedure does not cover other products or databases, such as the GC Column Database. Create a new system image after changing other products or databases.

This procedure requires that the user has administrative rights on the workstation.
Software backup procedure

Before the backup, make sure that the Run Queue on all active instruments is in idle state (no active run items in the queue) and all Acquisition client application are closed. Use Close Connection in the Control Panel to close any acquisitions that may still be running.

**Stop Windows Services**

Open Windows Services and Stop the following services in the order listed below. See Microsoft Management Console help for more information on stopping these services.

1. Agilent OpenLAB Shared Services
2. Agilent OpenLAB Instrument Service

![Stop Services]

**Figure 3** Stop Services
Create an Image of the Current System

Create a new system image after any change in your instrument configuration.

1. Connect a portable USB drive to a (blue) 3.0 USB port on the computer.

   The AutoPlay window displays the first time the drive is connected to the PC. Close the AutoPlay window.

2. Use the appropriate Windows program to create a system image. See Windows Help for more information.
   - In *Windows 7*, click **Backup and Restore** in the Microsoft Control Panel.

   ![Windows 7 Backup and Restore](image)

   **Figure 4**  Windows 7 Backup and Restore
- In Windows 8.1 or Windows 10, click **File History** in the Microsoft Control Panel, then click **System Image Backup**.

![Figure 5: Windows 8.1 File History](image-url)
3 Click **Create a system image**.
4 Click **Next**.
5 Select the drives you want to include in the backup.
   If the OpenLAB product was installed in a location other than C:\ drive, you must select that particular drive when asked **Which drives do you want to include in the backup?**
6 Click **Next**.

![Figure 7 Drives included in the backup](image)

**Figure 7** Drives included in the backup

7 Click **Start backup**.
8 If you are using Windows 7, create a system repair disc according to the Windows instructions.

![Create a system repair disc](image)

Figure 8  Create a system repair disc

If you are using Windows 8.1 or Windows 10, use the Recovery program from the Microsoft Control Panel and create a recovery drive according to the Windows instructions.

9 Close all remaining windows.

10 Eject the newly created Windows Recovery disc.

11 Disconnect the USB drive.

12 Complete the backup Solution Checklist.


**Start Windows Services**

Open Windows Services (services.msc) and Start the services in the order listed below. See Services Microsoft Management Console help for more information.

1 Agilent OpenLAB Shared Services

2 Agilent OpenLAB Instrument Service

You might need to wait a couple of minutes for the services to fully start.
Data Backup Procedure

Before the backup, make sure that the Run Queue on all active instruments is in idle state (no active run items in the queue) and all Acquisition client application are closed. Use **Close Connection** in the Control Panel to close any acquisitions that may still be running.

Stop Windows Services

Open Windows Services and Stop the following services in the order listed below. See Microsoft Management Console help for more information on stopping these services.

1. Agilent OpenLAB Shared Services
2. Agilent OpenLAB Instrument Service

![Stop Services](image-url)

**Figure 9**  Stop Services
Database Backup

1. Launch the **Shared Services Maintenance** utility and select the **Backup and Restore** tab.

   ![Backup utility screenshot](image)

   **Figure 10** Backup utility

2. Specify the backup directory and retention time. When a new backup is performed, the currently set retention time is used to delete any files older than specified.

   It is recommended that you use a safe location as the backup directory (for example, a thumb drive, a network location, or an external storage device).

3. Click **Backup**.

   The backup is placed in the specified backup directory. Backups older than the retention time are deleted.
Content Backup

1. Copy the contents of the project folder specified during installation into a safe location (for example, a thumb drive, a network location, or an external storage device).

NOTE
If you are using Secure Storage, your current Windows user needs to be a member of the AgtSfsGroup local group.

Start Windows Services

Open Windows Services (services.msc) and Start the services in the order listed below. See Services Microsoft Management Console help for more information.

1. Agilent OpenLAB Shared Services
2. Agilent OpenLAB Instrument Service

You might need to wait a couple of minutes for the services to fully start.

Scheduled Backup

To automate the data backup procedure, you can create a batch file performing all of the steps above and schedule it to run regularly using Windows Task Scheduler.

For your convenience, there is an example provided in the installation folder (for example, C:\Program Files (x86)\Agilent Technologies) under \BackupScripts. Please examine it carefully and adjust according to your system configuration.

NOTE
The script needs to be run with administrative privileges and as a user who has access to the project folder. If the project folder is secure, the user must be a member of the AgtSfsGroup local group.
Software Restore Procedure

Use this procedure to restore your system from an existing backup system image. See the Windows Installation documentation for detailed information.

1. Connect the recovery USB drive to a (blue) USB 3.0 port and insert the Windows Recovery DVD in the DVD drive.

2. Start or restart the PC and watch the PC monitor carefully during the restart process for the message Press any key to boot from CD or DVD.... Press the space bar or any other key when the message appears.
   The PC will boot from the DVD.

3. Enter the appropriate information to start the Install Windows program.

4. Select Repair your computer.

5. Specify system recovery options.
   - If you are using Windows 7, select the system recovery options according to the Windows instructions.

   ![System Recovery Options]

   **Figure 11** System recovery options

   - If you are using Windows 8.1, click Troubleshoot > Advanced Options > System Image Recovery > Choose a target operating system.
6 In the **Select a system image backup** screen, **Use the latest available system** image is selected by default.
   - If the auto-filled information is correct, click **Next**.
   - If no image match is found,
     a Select **Select a system image** and click **Next**
     b Select the appropriate image and click **Next**.
     c Select the date and time and click **Next**.

7 Select **Format and repartition disks** and click **Next**.

8 Click **Finish**.

9 When the re-image process is complete, restart the system to finish the restoration.
Data Recovery Procedure

Stop Windows Services

Open Windows Services and Stop the following services in the order listed below. See Microsoft Management Console help for more information on stopping these services.

1. Agilent OpenLAB Shared Services
2. Agilent OpenLAB Instrument Service

![Stop Services](image)

Figure 12  Stop Services
Content Restore

1 Copy the contents of previously preserved project folder to the location used at the moment of backup.

2 To restore a system with secured project folder:
   a Your current Windows user needs to be a member of the AgtSfsGroup local group.
   b Open an Administrative command prompt (type cmd into the Windows Start Menu search, right click cmd.exe, then select Run as administrator).
   c Execute the following commands:

```plaintext
   cd C:\Program Files (x86)\Agilent Technologies\OpenLAB Services\Server
   SecureFolder.exe /group C:\CDSProjects
```

NOTE In case of a non-default installation, replace C:\Program Files (x86)\Agilent Technologies and C:\CDSProjects with the OpenLAB CDS installation path and project folder selected during installation.

NOTE Incorrect usage of the SecureFolder.exe utility (specifying folder other than the Project Root) can harm other applications or even your operating system, and potentially prevent it from starting up.
Database Restore

1. Launch the Shared Services Maintenance utility and select the Backup and Restore tab.

2. Click Browse to select the folder with previously created backups.

   **NOTE**
   Backups older than the retention time will not to be shown.

3. Select the backup you want to restore, and click Restore.
**Start Windows Services**

Open *Windows Services* (services.msc) and **Start** the services in the order listed below. See Services Microsoft Management Console help for more information.

1. Agilent OpenLAB Shared Services
2. Agilent OpenLAB Instrument Service

**NOTE**

In case of a successful restore, the Shared Services service will start automatically.
7 System Setup and Maintenance
Maintenance Procedures
This chapter describes the uninstallation of the software.
8 Uninstall OpenLAB CDS With All of its Components

Uninstall OpenLAB CDS

Uninstall OpenLAB CDS

1 Log in as an administrator.

2 In the Microsoft Control Panel, open Programs and Features.

3 Uninstall the following programs:
   a Agilent driver software
      Driver software is not removed together with the OpenLAB CDS core component. Each driver must be uninstalled separately.
      
      ![ Agilent OpenLAB CDS - Agilent 35900 A/D
      ![ Agilent OpenLAB CDS - Agilent Data Player
      ![ Agilent OpenLAB CDS - Agilent GC
      ![ Agilent OpenLAB CDS - Agilent GC/MS
      ![ Agilent OpenLAB CDS - Agilent LC
      ![ Agilent OpenLAB CDS - Agilent LC/MS
      ![ Agilent OpenLAB CDS - Agilent SS420x

      Figure 14 OpenLAB CDS default drivers

   b OpenLAB CDS
      Double-click Agilent OpenLAB CDS.

      ![ Agilent OpenLAB CDS

      The Agilent Uninstallation Wizard opens. In the wizard, click Uninstall.

4 After uninstalling OpenLAB CDS, reboot.
Uninstall OpenLAB Help and Learning Only

If you installed OpenLAB Help and Learning only, follow this procedure to uninstall it.

1. Insert the USB media, right-click the setup.exe file, and run it as administrator. Alternatively, copy the content of the USB media to a network share, and run the setup.exe file from there.

2. On the start screen, select OpenLAB CDS, and click OK.

NOTE: If User Account Control (UAC) is switched on, this step requires active confirmation to continue.
8 Uninstall OpenLAB CDS With All of its Components
Uninstall OpenLAB Help and Learning Only

3 On the **Documentation** page, select **Install OpenLAB Help and Learning Only**.

The **Agilent OpenLAB CDS Help and Learning** wizard opens.
4 Select the correct language, then click **Next**.
8 Uninstall OpenLAB CDS With All of its Components
Uninstall OpenLAB Help and Learning Only

5 Click **Remove**.

The wizard removes OpenLAB Help and Learning from your system.
Appendix

Hardware and Software Requirements 100
  General Software Requirements 100
  Language Compatibility 101
  Disk Space 101
  Hardware 102
  Number of Instruments 102
  Software 103
Network Requirements 104
  Introduction 104
  LAN Connectivity 104
Operating System Configuration 109
  Configure Windows 10 109
  Configure Windows 8.1 112
  Configure Windows 7 116
Instrument Connections 121
  RC.NET Drivers compatible with OpenLAB CDS 121
  Agilent LC and LC/MS 122
  Agilent GC and GC/MS 131
  Other supported Agilent Instruments 135
  Third Party Instruments 136
  Incompatible Instruments and Modules 137
Privileges in the Control Panel 139
  Project Privileges 139
  Instrument Privileges 145
  Administrative Privileges 146
Sales and Support Assistance 147
Hardware and Software Requirements

General Software Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Details</th>
</tr>
</thead>
</table>
| .NET framework  | • .NET 3.5.1 must be enabled on systems running on Windows 8.1, Windows 10, or Windows Server 2012 R2.  
|                 |   and                                                                     |
|                 | • .NET 4.5 or above (if needed, it will be installed automatically by the OpenLAB Installer) |
| Web browser     | • Internet Explorer 11                                                 |
|                 | • Google Chrome 40 or higher                                           |
| Antivirus software¹ | • Symantec Endpoint Protection                                         |
|                 | • Trend Micro                                                           |
|                 | • Microsoft Security Essentials                                         |
|                 | • McAfee                                                                |

¹ The listed antivirus software has been tested and is recommended by Agilent. Check with your Agilent service person in case you want to use other software.

The following software is recommended to be installed or enabled on any supported operating system prior to installing OpenLAB CDS components. It is not required for the system to function correctly. You will need it, however, to view videos or PDF manuals in OpenLAB Help & Learning.

• Adobe Flash Player 17
• Adobe Reader XI

NOTE If these tools are not installed on your system, you can install them from the OpenLAB CDS Installer.
Language Compatibility

The English version of OpenLAB CDS is validated on Windows English and Western European language operating systems. Regional settings (locales) can be adjusted as required. In a Client/Server system make sure regional settings are the same for the server, AIC and clients.

Localized versions of OpenLAB CDS are supported on localized language versions of Windows, using default system fonts:

- Chinese: Simsun
- Japanese: MS UI Gothic
- Brazilian Portuguese MS Sans Serif

OpenLAB CDS can run on other language versions of Windows as well, but the user interface will be English.

Non-localized instrument drivers are supported and will appear in English even when running localized versions of OpenLAB CDS.

Disk Space

Disk space requirements should be adjusted based on the number and type of instruments and archival periodicity. Agilent recommends providing enough disk space for one year of lab operation, in addition to the operating system and OpenLAB CDS requirements.

Table 4   Typical expected file sizes

<table>
<thead>
<tr>
<th>Run time</th>
<th>Description</th>
<th>Expected data size</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D data</td>
<td>60 min 10 Hz, 2 channel data</td>
<td>300-700 KB</td>
</tr>
<tr>
<td>3D data</td>
<td>60 min 10 Hz, 5 channel data, spectra at 1 nm resolution from 200 to 400 nm</td>
<td>100-300 MB</td>
</tr>
<tr>
<td>LC/MS data (SQ)</td>
<td>60 min  Scan mode</td>
<td>20-40 MB</td>
</tr>
<tr>
<td>GC/MS data (SQ)</td>
<td>60 min Scan mode</td>
<td>50-300 MB</td>
</tr>
<tr>
<td>GC/MS data (SQ)</td>
<td>60 min SIM mode with 2 ions</td>
<td>1-3 MB</td>
</tr>
</tbody>
</table>
Hardware

Table 5  Minimum hardware configuration for an OpenLAB CDS Workstation

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor speed (CPU)</td>
<td>Intel® Xeon E3, 3.2 GHz, 8MB Cache, 4 Core, Hyper Threading, Intel® vPro TM Technology, Intel® HD Graphics, or equivalent</td>
</tr>
<tr>
<td>Physical memory (RAM)</td>
<td>8 GB</td>
</tr>
<tr>
<td>Hard disk</td>
<td>1 x 500 GB SATA 7200 RPM</td>
</tr>
<tr>
<td>Graphic Resolution</td>
<td>1600 x 900</td>
</tr>
<tr>
<td>RS-232 port</td>
<td>1 serial port</td>
</tr>
<tr>
<td>USB port</td>
<td>1</td>
</tr>
<tr>
<td>LAN card</td>
<td>Integrated Intel® I217LM PCIe GbE Controller</td>
</tr>
</tbody>
</table>

Number of Instruments

You can configure any number of instruments that sums up to \( \frac{1}{4} \) instrument points per OpenLAB CDS Workstation.

Instrument points are an indicator for the data stream that needs to be managed, and thus also for the required hardware and software. Instruments count as follows:

- GC: 1 instrument point
- LC: 1 instrument point
- 3D LC: 2 instrument points
- GC/MS: 3 instrument points
- LC/MS: 3 instrument points
Software

Table 6  Supported operating systems for a workstation

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>• Windows 10, Enterprise or Professional, 64bit</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>• Windows 7 SP1, Enterprise or Professional, 64bit</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>• Windows 8.1, Enterprise or Professional, 64bit</td>
</tr>
</tbody>
</table>
Network Requirements

This chapter describes the network requirements that must be met in order to support the environmental computing needs of an OpenLAB Chromatography Data System (CDS).

Introduction

OpenLAB CDS systems rely on network infrastructure in order to support the communication between various system nodes. This communication is based on standard TCP/IP protocols. In order to provide optimum performance and uptime, the network must meet design criteria for available bandwidth, IP address assignment, name resolution and appropriate isolation of the lab subnet from the corporate network.

LAN Connectivity

When using LAN communications to connect workstations or instrument controllers to an instrument, use one of these methods:

• Connect via an isolated switch using standard CAT-5 network cabling
• LAN communication hardware should be 100/1000 mbps (or higher) speed capable.
• NIC teaming\(^1\): LAN cards should not be teamed on workstations, instrument controllers, or clients.
• LAN communication must be on the same subnet as instruments, and preferably on the same segment.

NOTE

See the separate driver installation guides for further information regarding vendor specific instrument connections. GPIB or RS232 might be required.

\(^1\) Network Interface Card (NIC) teaming is also known as Load Balancing and Failover (LBFO)
LAN Power Management

Avoid data capture or transfer interruptions in your data acquisition system by making LAN communication cards available for instrument and system component communications.

Windows may be set to turn instruments/components off to save power while sleeping or hibernating. To change this setting:

1. In the Microsoft Control Panel, open the **Network and Sharing Center**.
2. Select **Change adapter settings**. Right-click **Local Area Connection > Properties > Configure**.
3. Select the **Power Management** tab.
4. Clear the **Allow the computer to turn off this device to save power** check box.

Firewall Settings

If you are using a third party firewall or antivirus software on the network where OpenLAB CDS is installed, open these firewall ports to allow communication between the system components of OpenLAB CDS. These apply to workstations as well as to Client/Server systems as component communications rely on these communication channels:

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>GC MSD - Firmware Installation (FTP)</td>
</tr>
<tr>
<td>23</td>
<td>GC MSD - Firmware Installation (Telnet)</td>
</tr>
<tr>
<td>25</td>
<td>Agilent OpenLAB send eMail (SMTP)</td>
</tr>
<tr>
<td>67 and 68</td>
<td>BootP Server communications</td>
</tr>
<tr>
<td>80</td>
<td>GC MSD - Embedded Web Server HTTP</td>
</tr>
<tr>
<td></td>
<td>McAfee</td>
</tr>
<tr>
<td>111, 1007, 1024-1025</td>
<td>GC MSD - Instrument Control (Proprietary/SunRPC/TCP)</td>
</tr>
<tr>
<td>2883-2885</td>
<td>GC MSD - Instrument Control (Proprietary/SunRPC/TCP)</td>
</tr>
<tr>
<td>2886</td>
<td>Agilent OpenLAB Automation Services</td>
</tr>
<tr>
<td></td>
<td>GC MSD - Instrument Control (Proprietary/SunRPC/TCP)</td>
</tr>
<tr>
<td>3068 and 3071</td>
<td>GC MSD - Instrument Control (Proprietary/SunRPC/TCP)</td>
</tr>
</tbody>
</table>

1 View the items by icon to see a list of all items.
# Appendix

## Network Requirements

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port 3424</td>
<td>Transfer of diagnostics information between OpenLAB CDS system components</td>
</tr>
<tr>
<td>Port 4879</td>
<td>Required for Headspace events</td>
</tr>
<tr>
<td>Port 5813</td>
<td>GC MSD - Firmware Installation (ICMP/Ping)</td>
</tr>
<tr>
<td>Port 5973</td>
<td>GC MSD - Instrument Control (Proprietary/SunRPC/TCP)</td>
</tr>
<tr>
<td>Port 6570</td>
<td>SubscribeNet: active retrieval and release of product licenses</td>
</tr>
<tr>
<td>Port 6577</td>
<td>Communications of OpenLAB CDS administrative information. This includes instrument and run status, active trace data, and global configurations.</td>
</tr>
<tr>
<td>Port 6624</td>
<td>Agilent OpenLAB REST API</td>
</tr>
<tr>
<td>Ports 7972 and 7973</td>
<td>GC MSD - Instrument Control</td>
</tr>
<tr>
<td>Ports 7980-7983</td>
<td>GC MSD - Instrument Control - RSlick (TCP)</td>
</tr>
<tr>
<td>Port 8084</td>
<td>Agilent OpenLAB Licensing support</td>
</tr>
<tr>
<td>Ports 8085-8089</td>
<td>Alternative to port 8084 if that port is in use by another page or process</td>
</tr>
<tr>
<td>Port 8090</td>
<td>Hosts the viewing page of current license grants and consumptions found in the Control Panel administration interface</td>
</tr>
<tr>
<td>Ports 9001-9002</td>
<td>Communication with instruments and shared servers</td>
</tr>
<tr>
<td>Port 9110</td>
<td>Instrument comm (GC/LC)</td>
</tr>
</tbody>
</table>
| Port 9753    | Task-based messaging communication between acquisition controllers and chromatography clients  
                Configurable during AIC registration. It is required that all ports designated during AIC registration be opened for access. |
| Ports 10000-10010 | Status and acquisition communication with Agilent 7890 GCs                   |
| Ports 27000-27009 | Communication of license availability                                      |
| Port 55065   | GC MSD - Instrument Control - RSlick (TCP)                                   |
| Dynamic Ports: | Temporary communications between clients and instrument controllers  
                The ports used depend on the operating system in use and are configurable. Refer to the operating system documentation for more information. |

The OpenLAB CDS installer will automatically open these ports on an enabled Windows firewall during installation.
Domain Requirements

Domains support the flow of information and user access rights across machines in the network. This means that all machines and instruments within the networked OpenLAB CDS system must reside within the same domain or have the appropriate cross domain trusts to allow name based communications between all components in the system. In the case of a workstation installation, domains are only relevant if you are using a Windows domain-based authentication model. In this case the workstation or client must always be able to communicate with domain components in order to function as expected.

Installing OpenLAB CDS will apply network exceptions to the Windows firewall under the domain profile to result in a functional system. The components necessary to support OpenLAB CDS on a domain are:

- **Domain controller** — broadcasts the domain name and negotiates access to machines.
- **Domain name server (DNS)** — maintains records of what hostnames belong to which IP on the network. This component is always required for effective components communications in networked systems.
- **Active directory** — maintains the list of users and their access rights on the domain.

**NOTE**

The domain name server (DNS) must be able to resolve the IPv4 address of all instrument controllers and instruments. Any unresolved instrument controller or instrument will disrupt the functionality of OpenLAB resulting in errors or delays. IPv6 is not supported and must be deactivated.

**NOTE**

OpenLAB CDS components must not be installed on the same machine as the domain controller.
The domain components above host a variety of services and settings that must be configured appropriately to allow communication across machines. The following services and settings will need to be configured to fit your domain. Your internal IT group is responsible for proper configuration of any custom domain solutions. These include settings for:

- Lookup zones and hostnames
- Group and security policies
- Subnet masks and Virtual LANs
- IP reservation (static or DHCP)

**Environments with Proxy Servers**

The OpenLAB server must be accessible via http or https in the network. If you use proxy servers, verify that they can be accessed. If required, adjust the proxy settings.
Operating System Configuration

Configure Windows 10

[MUST] 1 System (Microsoft Control Panel): Register Windows with Microsoft.

[MUST] 2 Folder Options (Microsoft Control Panel): In the View tab,
   - Clear Hide extensions for known file types.
   - Enable Display the full path in the title bar.
   - Clear Use Sharing Wizard.

[MUST] 3 Check for updates and apply all critical security patches (Go to Start > Settings > Update and Security):
   Click Check for updates.

[MUST] 4 Settings for updates: Keep the Windows Update service running during installation.

[MUST] 5 Indexing Options (Microsoft Control Panel): Disable indexing.
   Click the Modify button. Clear all drives and locations.

[MUST] 6 Power Options (Microsoft Control Panel):
   a As preferred plan select High performance
   b Click Change Plan settings
   c Set the option Put the computer to sleep to Never.
   d Click Change advanced power settings.
   e Open the nodes for Hard disk > Turn off hard disk after.
   f Set the Minutes to 0 (=Never).

1 View the items by icon to see a list of all items.
[MUST]  7 Administrative Tools (Microsoft Control Panel):
   a  Double-click Local Security Policy.
   b  Navigate to Security Settings > Local Policies > Security Options
   c  Double-click the following policy listed in the right hand panel: Network Access: Sharing and security model for local accounts
   d  In the displayed dialog select the following item from the drop-down list: Classic - local users authenticate as themselves

[MUST]  8 Date and Time (Microsoft Control Panel): Choose the time zone of your machine's location.

[MUST]  9 Network and Sharing Center (Microsoft Control Panel):
   a  Select Change adapter settings. Right-click Local Area Connection > Properties > Configure.
   b  On the Power Management tab, clear all check boxes.

[MUST] 10 Programs and Features (Microsoft Control Panel):
   a  Click Turn Windows features on or off.
   b  Enable .NET 3.5 by selecting the .NET Framework 3.5 (includes .NET 2.0 and 3.0) check box.
      This option requires an internet connection.
   c  To make sure that all the net.tcp components are properly initialized, non-http activation must be enabled. Expand the .NET Framework 3.5 (includes .NET 2.0 and 3.0) node and select the Windows Communication Foundation Non-HTTP Activation check box.

[MUST] 11 Disable Compatibility View in Internet Explorer.
   a  Open Internet Explorer.
   b  Click the Tools menu, and then click Compatibility View Settings.
   c  Clear the Display intranet sites in Compatibility View check box.

NOTE
If this procedure does not work as expected, or the computer has no internet access, install .NET 3.5 from the Windows installation media (see details for Windows 10 under https://support.microsoft.com/en-us/kb/2734782). If you do not have installation media, create them as described under https://www.microsoft.com/en-us/software-download/windows10.
[PERFORMANCE] 12 System (Microsoft Control Panel): Change performance options:
   a  Click **Advanced system settings**.
   b  On the **Advanced** tab > **Performance** click **Settings**.
   c  On the **Visual Effects** tab, select **Adjust for best performance**.
   d  Save the settings.

[PERFORMANCE] 13 System (Microsoft Control Panel): Change system properties:
   a  Click **Advanced system settings**.
   b  On the **Advanced** tab > **Performance** click **Settings**.
      - **Advanced** tab > **Virtual Memory**: For optimum performance use the **Change** button to adjust the paging file size to a value of 2 to 3 times of the physical RAM on the PC. If possible locate the paging file on a drive different from the system installation drive.
      - **Data Execution Prevention** tab: Select **Turn on DEP for essential Windows programs and services only**.
   c  **Advanced** > **Startup and Recovery** > **Settings** button:
      - **System startup** section:
         Change both **Time to display ...** fields from 30 to 3 sec.
      - **System failure** section:
         Select **Automatically restart**, in the **Write debugging information** section select **Kernel memory dump** from the drop-down list.

[OPTIONAL] 14 Welcome Center (**Start** > search for 'gpedit.msc'):
   a  Navigate to **Local Computer Policy** > **Computer Configuration** > **Administrative Templates** > **System** > **Logon**.
   b  Set **Don't display the Getting Started welcome screen at logon** to **Enabled**.

[OPTIONAL] 15 Recycle Bin Properties: (right-click on desktop icon **Recycle Bin**) Select the following options:
   - **Custom size**: Select a size corresponding to approximately 10% of the complete disk space for the drive.
   - Select **Display delete confirmation dialog**.
Repeat these steps for all drives of your computer.
16 Region (Microsoft Control Panel): Language for non-Unicode programs:
   On the Administrative tab, click Change system locale.... From the drop down list, select English (United States).

NOTE
Do not the change system locale if you are using an English, Portuguese, Japanese or Chinese Operating System.

Configure Windows 8.1

[MUST] 1 System (Microsoft Control Panel): Register Windows with Microsoft.

[MUST] 2 Folder Options (Microsoft Control Panel): In the View tab,
   • Clear Hide extensions for known file types.
   • Enable Display the full path in the title bar.
   • Clear Use Sharing Wizard.

[MUST] 3 Windows Update (Microsoft Control Panel):
   Click Check for updates to check for updates and apply all critical security patches.

[MUST] 4 Windows Update (Microsoft Control Panel): Change the settings for updates:
   Click Change settings. In the Important updates section, select Never check for updates. Clear the other update options.

NOTE
This setting is required during installation of OpenLAB CDS.

On clients in a client/server system, you may activate automatic updates again after finishing the installation.

On Agilent Instrument Controllers (AIC) or standalone workstations, keep the Never check for updates setting. This setting is important to avoid data loss due to system reboot during data acquisition.

[MUST] 5 Indexing Options (Microsoft Control Panel): Disable indexing.
   Click the Modify button. Clear all drives and locations.

1 View the items by icon to see a list of all items.
[MUST] 6 Power Options (Microsoft Control Panel):
   a. As preferred plan select **High performance**
   b. Click **Change Plan settings**
   c. Set the option **Put the computer to sleep** to **Never**.
   d. Click **Change advanced power settings**.
   e. Open the nodes for **Hard disk > Turn off hard disk after**.
   f. Set the Minutes to 0 (=Never).

[MUST] 7 Administrative Tools (Microsoft Control Panel):
   a. Double-click **Local Security Policy**.
   b. Navigate to **Security Settings > Local Policies > Security Options**
   c. Double-click the following policy listed in the right hand panel: **Network Access: Sharing and security model for local accounts**
   d. In the displayed dialog select the following item from the drop-down list: **Classic - local users authenticate as themselves**

[MUST] 8 Date and Time (Microsoft Control Panel): Choose the time zone of your machine's location.

[MUST] 9 Network and Sharing Center (Microsoft Control Panel):
   a. Select **Change adapter settings**. Right-click **Local Area Connection > Properties > Configure**.
   b. On the **Power Management** tab, clear all check boxes.
Appendix
Operating System Configuration

[MUST] 10 .NET settings (Go to Control Panel > Programs and Features):

a  Click Turn Windows features on or off.

b  Enable .NET 3.5 by selecting the .NET Framework 3.5 (includes .NET 2.0 and 3.0) check box.

This option requires an internet connection.

[NOTE] If this procedure does not work as expected, or the computer has no internet access, install .NET 3.5 from the Windows installation media (see Method 3 under https://support.microsoft.com/en-us/kb/2734782). If you do not have installation media, create them as described under http://windows.microsoft.com/en-US/windows-8/create-reset-refresh-media?woldogcb=0.

c  To make sure that all the net.tcp components are properly initialized, non-http activation must be enabled. Expand the .NET Framework 3.5 (includes .NET 2.0 and 3.0) node and select the Windows Communication Foundation Non-HTTP Activation check box.

[MUST] 11 Disable Compatibility View in Internet Explorer.

a  Open Internet Explorer.

b  Click the Tools menu, and then click Compatibility View Settings.

c  Clear the Display intranet sites in Compatibility View check box.

[PERFORMANCE] 12 System (Microsoft Control Panel): Change performance options:

a  Click Advanced system settings.

b  On the Advanced tab > Performance click Settings.


d  Save the settings.
13 System (Microsoft Control Panel): Change system properties:

a Click Advanced system settings.

b On the Advanced tab > Performance click Settings.
   - Advanced tab > Virtual Memory: For optimum performance use the Change button to adjust the paging file size to a value of 2 to 3 times of the physical RAM on the PC. If possible locate the paging file on a drive different from the system installation drive.
   - Data Execution Prevention tab: Select Turn on DEP for essential Windows programs and services only.

c Advanced > Startup and Recovery > Settings button:
   - System startup section:
     Change both Time to display ... fields from 30 to 3 sec.
   - System failure section:
     Select Automatically restart, in the Write debugging information section select Kernel memory dump from the drop-down list.

14 Welcome Center (Start > search for ‘gpedit.msc’):

a Navigate to Local Computer Policy > Computer Configuration > Administrative Templates > System > Logon.

b Set Don't display the Getting Started welcome screen at logon to Enabled.

15 Recycle Bin Properties: (right-click on desktop icon Recycle Bin) Select the following options:
   - Custom size: Select a size corresponding to approximately 10% of the complete disk space for the drive.
   - Select Display delete confirmation dialog.

Repeat these steps for all drives of your computer.

16 Region (Microsoft Control Panel): Language for non-Unicode programs:

On the Administrative tab, click Change system locale.... From the drop down list, select English (United States).

NOTE Do not change system locale if you are using an English, Portuguese, Japanese or Chinese Operating System.
Appendix
Operating System Configuration

Configure Windows 7

[MUST] 1 System (Microsoft Control Panel): Register Windows with Microsoft.

[MUST] 2 Folder Options (Microsoft Control Panel): In the View tab,
   - Clear Hide extensions for known file types.
   - Enable Display the full path in the title bar.
   - Clear Use Sharing Wizard.

[MUST] 3 Windows Update (Microsoft Control Panel):
   Click Check for updates to check for updates and apply all critical security patches.

[MUST] 4 Windows Update (Microsoft Control Panel): Change the settings for updates:
   Click Change settings. In the Important updates section, select Never check for updates. Clear the other update options.

NOTE
This setting is required during installation of OpenLAB CDS.
On clients in a client/server system, you may activate automatic updates again after finishing the installation.
On Agilent Instrument Controllers (AIC) or standalone workstations, keep the Never check for updates setting. This setting is important to avoid data loss due to system reboot during data acquisition.

[MUST] 5 Indexing Options (Microsoft Control Panel): Disable indexing.
   Click the Modify button. Clear all drives and locations.

[MUST] 6 Windows logon options (Start > search for ’gpedit.msc’)
   a Navigate to Local Computer Policy > Computer Configuration > Administrative Templates > System > Logon.
   b Set Hide entry points for Fast User Switching and Always use classic logon to Enabled.

1 View the items by icon to see a list of all items.
[MUST]  7 Power Options (Microsoft Control Panel):
   a As preferred plan select High performance
   b Click Change Plan settings
   c Set the option Put the computer to sleep to Never.
   d Click Change advanced power settings.
   e Open the nodes for Hard disk > Turn off hard disk after.
   f Set the Minutes to 0 (=Never).

[MUST]  8 Administrative Tools (Microsoft Control Panel):
   a Double-click Local Security Policy.
   b Navigate to Security Settings > Local Policies > Security Options
   c Double-click the following policy listed in the right hand panel: Network Access: Sharing and security model for local accounts
   d In the displayed dialog select the following item from the drop-down list: Classic - local users authenticate as themselves

[MUST]  9 Date and Time (Microsoft Control Panel): Choose the time zone of your machine's location.

[MUST]  10 Network and Sharing Center (Microsoft Control Panel):
   a Select Change adapter settings. Right-click Local Area Connection > Properties > Configure.
   b On the Power Management tab, clear all check boxes.

[MUST]  11 Programs and Features (Microsoft Control Panel): Enable non-http activation.
   a Click Turn Windows features on or off.
   b Expand the Microsoft .NET Framework 3.5.1 node and select the Windows Communication Foundation Non-HTTP Activation check box.

[MUST]  12 Disable Compatibility View in Internet Explorer.
   a Open Internet Explorer.
   b Click the Tools menu, and then click Compatibility View Settings.
   c Clear the Display intranet sites in Compatibility View check box.
Appendix
Operating System Configuration

[PERFORMANCE] 13 System (Microsoft Control Panel): Change performance options:
   a Click Advanced system settings.
   b On the Advanced tab > Performance click Settings.
   d Save the settings.

[PERFORMANCE] 14 System (Microsoft Control Panel): Change system properties:
   a Click Advanced system settings.
   b On the Advanced tab > Performance click Settings.
      · Advanced tab > Virtual Memory: For optimum performance use the Change button to adjust the paging file size to a value of 2 to 3 times of the physical RAM on the PC. If possible locate the paging file on a drive different from the system installation drive.
      · Data Execution Prevention tab: Select Turn on DEP for essential Windows programs and services only.
   c Advanced > Startup and Recovery > Settings button:
      · System startup section:
         Change both Time to display ... fields from 30 to 3 sec.
      · System failure section:
         Select Automatically restart, in the Write debugging information section select Kernel memory dump from the drop-down list.

[OPTIONAL] 15 General Layout: (right-click Start > Properties)
   a Start Menu Tab: In the Privacy section select both items
   b Start Menu Tab > Customize button: In Customize Start Menu dialog:
      · Clear the following option:
         · Favorites menu
      · Select the following options:
         · Computer Display as a link
         · Connect To
         · Control Panel: Display as a menu
         · Default Programs
         · Devices and Printers
         · Documents: Display as a link
- Enable context menus and dragging and dropping
- Games: Don’t display this item
- Help
- Highlight newly installed programs
- Music: Don’t display this item
- Network
- Open submenus when I pause on them with the mouse pointer
- Personal folder: Display as a link
- Pictures: Display as a link
- Run command
- Search other files and libraries Search with public folders
- Search programs and Control Panel
- Sort All Programs menu by name
- System administrative tools: Display on the All Programs menu and in the Start menu
- Use large icons

**[OPTIONAL] 16 Welcome Center (Start > search for 'gpedit.msc'):**


b. Set Don’t display the Getting Started welcome screen at logon to Enabled.

**[OPTIONAL] 17 Recycle Bin Properties:** (right-click on desktop icon Recycle Bin) Select the following options:

- **Custom size:** Select a size corresponding to approximately 10% of the complete disk space for the drive.

- Select Display delete confirmation dialog.

Repeat these steps for all drives of your computer.
[OPTIONAL] **18 Region and Language** (Microsoft Control Panel): Set the language for non-Unicode programs.

On the **Administrative** tab, click **Change system locale**. From the drop down list, select **English (United States)**.

**NOTE** Do not change the system locale if you are using an English, Portuguese, Japanese or Chinese Operating System.
Instrument Connections

This section provides information on the instruments supported by the current revision of OpenLAB CDS and the required respective instrument drivers and firmware revisions.

**RC.NET Drivers compatible with OpenLAB CDS**

OpenLAB CDS can control instruments and modules that use **RC.NET** based driver software only.

Agilent and other vendors may release RC.net drivers independent of the OpenLAB CDS releases. Agilent recommends always using the most recent firmware revisions which include latest firmware features and improvements. Agilent driver software is forward compatible with respect to firmware, i.e. the firmware can be updated without the need of updating the driver or CDS.

More information on instrument drivers and firmware is available in the respective RC.net driver release notes.

The following instrument driver software revisions are part of the OpenLAB CDS 2.1 software package, and are installed by default with the software:

**Table 7** Driver packages shipped and installed with OpenLAB CDS 2.1

<table>
<thead>
<tr>
<th><strong>RC.net Instrument Driver</strong></th>
<th><strong>Driver Software Revision</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Agilent LC</td>
<td>A.02.14</td>
</tr>
<tr>
<td>Agilent LC/MS SQ</td>
<td>A.01.01</td>
</tr>
<tr>
<td>Agilent GC</td>
<td>A.03.02</td>
</tr>
<tr>
<td>Agilent GC/MS SQ</td>
<td>A.01.01</td>
</tr>
<tr>
<td>Agilent 35900E A/D</td>
<td>B.01.01.15272</td>
</tr>
<tr>
<td>Agilent SS420X</td>
<td>A.01.01.64</td>
</tr>
<tr>
<td>Agilent Data Player</td>
<td>A.01.02.010</td>
</tr>
</tbody>
</table>
Additional **RC.NET** instrument drivers are supported with OpenLAB CDS. You will need to install them separately (see section *Install or Upgrade Driver Software* in chapter 1 of your Workstation or Client Server guide).

Supported Agilent drivers are listed in the following table with their minimum software revisions.

**Table 8**  Other compatible Agilent Instrument Drivers (on the installation medium)

<table>
<thead>
<tr>
<th>RC.net Instrument Driver</th>
<th>Driver Software Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTC PAL3</td>
<td>A.01.03</td>
</tr>
<tr>
<td>PAL XT</td>
<td>B.01.08</td>
</tr>
<tr>
<td>ELSD</td>
<td>A.01.05</td>
</tr>
<tr>
<td>Agilent 490 Micro GC</td>
<td>B.01.12</td>
</tr>
<tr>
<td>Agilent Headspace</td>
<td>B.01.07.1</td>
</tr>
</tbody>
</table>

**Third Party Drivers**

OpenLAB CDS 2.1 supports selected third party instruments. See Table 15 on page 136 for more details.

Always install dedicated RC.net drivers available from SubscribeNet at OpenLAB CDS > OpenLAB 3rd-Party Instrument drivers.

**Agilent LC and LC/MS**

**Agilent LC**

Most Agilent LC Modules can be controlled with the current version of OpenLAB CDS. LC driver release A.02.14 has been tested with this revision and is installed by default with the software.

**Recommended Firmware**

The tables below “Supported LC modules” on page 123 list the supported LC modules with the minimum required Firmware. Newer Firmware can be

In order to ensure full functionality of all features provided by LC driver release A.02.14, Agilent recomeds the firmware sets listed below or any later firmware. All LC modules need to have firmware from the same firmware set. Mixing different sets in one instrument is not supported.

<table>
<thead>
<tr>
<th>Device</th>
<th>Firmware</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agilent 1100 Series, 1200 Series and 1200 Infinity</td>
<td>A.07.01</td>
</tr>
<tr>
<td>Agilent 1200 Series, 1200 Infinity and 1120 Compact LC</td>
<td>B.07.01</td>
</tr>
<tr>
<td>Agilent 1200 Infinity Hosted Modules</td>
<td>C.07.01</td>
</tr>
<tr>
<td>Agilent 1260/1290 Infinity II Modules</td>
<td>D.07.01</td>
</tr>
</tbody>
</table>

**Supported LC modules**

Check for the product number at the lower right of each module or system.

**Agilent LC - Sampling Systems**

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Module Name</th>
<th>Minimum Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G1313A</td>
<td>1100 Series Standard Autosampler</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1329A</td>
<td>1100 Series Standard Autosampler</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1329B</td>
<td>1260 Infinity Standard Autosampler</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1330A/B</td>
<td>1200 Thermostat</td>
<td>n/a</td>
</tr>
<tr>
<td>G1367A</td>
<td>1100 Series Well-plate Sampler</td>
<td>A.06.31</td>
</tr>
<tr>
<td>G1367B</td>
<td>1200 Series High Performance Autosampler</td>
<td>A.06.31</td>
</tr>
<tr>
<td>G1367C</td>
<td>1200 Series High Performance Autosampler SL</td>
<td>A.06.31</td>
</tr>
<tr>
<td>G1367D</td>
<td>1200 Series High Performance Autosampler SL+</td>
<td>A.06.31</td>
</tr>
<tr>
<td>G1367E</td>
<td>1260 Infinity High Performance Autosampler</td>
<td>A.06.32</td>
</tr>
</tbody>
</table>
### Instrument Connections

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Module Name</th>
<th>Minimum Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G4226A</td>
<td>1290 Infinity Autosampler</td>
<td>A.06.31</td>
</tr>
<tr>
<td>G4303A</td>
<td>1260 Infinity SFC standard autosampler</td>
<td>A.06.54</td>
</tr>
<tr>
<td>G5667A</td>
<td>1260 Bio-inert High Performance Sampler</td>
<td>A.06.32</td>
</tr>
<tr>
<td>G5668A</td>
<td>1260 Infinity II Bio-inert Multisampler</td>
<td>D.07.01</td>
</tr>
<tr>
<td>G7129A</td>
<td>1260 Infinity Vialsampler</td>
<td>D.06.76</td>
</tr>
<tr>
<td>G7129B</td>
<td>1290 Infinity II Vialsampler</td>
<td>D.06.76</td>
</tr>
<tr>
<td>G7167A</td>
<td>1260 Infinity II Multisampler</td>
<td>D.06.75</td>
</tr>
<tr>
<td>G7167B</td>
<td>1290 Infinity II Multisampler</td>
<td>D.06.75</td>
</tr>
</tbody>
</table>

**Table 9**  Agilent CTC PAL Autosampler with Agilent LC

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Module Name</th>
<th>Minimum Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G4277A</td>
<td>Agilent 1290 Infinity LC Injector HTS</td>
<td>Agilent 2.6.8 or 4.1.5</td>
</tr>
<tr>
<td>G4278A</td>
<td>Agilent 1290 Infinity LC Injector HTC</td>
<td>Agilent 2.6.8 or 4.1.5</td>
</tr>
<tr>
<td>G4270-CTC</td>
<td>HTC PAL Auto sampler</td>
<td>Agilent 2.6.8 or 4.1.5</td>
</tr>
<tr>
<td>G4271-CTC</td>
<td>HTS PAL Auto sampler</td>
<td>Agilent 2.6.8 or 4.1.5</td>
</tr>
</tbody>
</table>
## Agilent LC – Pumps

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Module Name</th>
<th>Minimum Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G1310A</td>
<td>1100 Series Isocratic Pump</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1310B</td>
<td>1260 Infinity Isocratic Pump</td>
<td>A.06.32</td>
</tr>
<tr>
<td>G1311A</td>
<td>1100 Series Quaternary Pump ¹</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1311B</td>
<td>1260 Infinity Quaternary Pump ¹</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1311C</td>
<td>1260 Infinity Quaternary Pump VL ¹</td>
<td>A.06.32</td>
</tr>
<tr>
<td>G1312A</td>
<td>1260 Infinity Binary Pump ¹</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1312B</td>
<td>1260 Infinity Binary Pump SL ¹</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1312C</td>
<td>1260 Infinity Binary Pump VL ¹</td>
<td>A.06.32</td>
</tr>
<tr>
<td>G4204A</td>
<td>1290 Quaternary Pump ¹</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4220A</td>
<td>1290 Infinity Binary Pump ¹</td>
<td>B.06.23</td>
</tr>
<tr>
<td>G4220B</td>
<td>1290 Infinity Binary Pump</td>
<td>B.06.43</td>
</tr>
<tr>
<td>G4302A</td>
<td>1260 Infinity SFC Binary Pump ¹</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G5611A</td>
<td>1260 Infinity Bio-inert Quaternary Pump ¹</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G5654A</td>
<td>1260 Infinity II Bio Quat Pump</td>
<td>D.07.01</td>
</tr>
<tr>
<td>G7104A</td>
<td>1290 Infinity II Flexible Pump</td>
<td>B.06.71</td>
</tr>
<tr>
<td>G7110B</td>
<td>1260 Infinity II Iso. Pump</td>
<td>D.07.01</td>
</tr>
<tr>
<td>G7111A</td>
<td>1260 Infinity II Quat. Pump VL</td>
<td>D.07.01</td>
</tr>
<tr>
<td>G7111B</td>
<td>1260 Infinity II Quat. Pump</td>
<td>D.07.01</td>
</tr>
<tr>
<td>G7112B</td>
<td>1260 Infinity II Bin. Pump</td>
<td>D.07.01</td>
</tr>
<tr>
<td>G7120A</td>
<td>1290 Infinity II High Speed Pump</td>
<td>B.06.71</td>
</tr>
</tbody>
</table>

¹ Pump valve clusters are possible for marked pumps with up to 2 valves of type G1160A and/or G1170A
## Agilent LC – Column Compartments

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Module Name</th>
<th>Minimum Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G1316A</td>
<td>1260 Infinity Thermostatted Column Compartment</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1316B</td>
<td>1200 Series Column Compartment SL</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1316C</td>
<td>1200 Series Thermostatted Column Compartment SL</td>
<td>A.06.14</td>
</tr>
<tr>
<td>G7116A</td>
<td>1260 Infinity II Multicolumn Thermostat</td>
<td>B.07.01</td>
</tr>
<tr>
<td>G7116B</td>
<td>1290 Infinity II Multicolumn Thermostat</td>
<td>B.06.75</td>
</tr>
<tr>
<td>G7130A</td>
<td>Integrated Column Compartment ICC</td>
<td>D.06.76</td>
</tr>
<tr>
<td>VTC Valve thermostat cluster</td>
<td>Combinations of G7116B, G1170A and G1316C (valve or column hosts) and G1316A/B and G7130A</td>
<td>See Valve-Thermostat Cluster in the LC Driver Release Notes</td>
</tr>
</tbody>
</table>

1 Cluster with up to three G1316C with integrated 8pos/9port valves (products G4230A/B). Minimum two G1316C TCCs, the third TCC can be a G1316A, B or C.

## Agilent LC – Detectors

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Module Name</th>
<th>Minimum Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G1314A</td>
<td>1100 Series Variable Wavelength Detector</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1314B</td>
<td>1200 Series Variable Wavelength Detector</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1314C</td>
<td>1200 Series Variable Wavelength Detector</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1314D</td>
<td>1200 Series Variable Wavelength Detector</td>
<td>B.06.32</td>
</tr>
<tr>
<td>G1314E</td>
<td>1290 Infinity Variable Wavelength Detector</td>
<td>B.06.32</td>
</tr>
<tr>
<td>G1314F</td>
<td>1260 Infinity Variable Wavelength Detector</td>
<td>B.06.32</td>
</tr>
<tr>
<td>G1315A</td>
<td>1100 Series Diode Array Detector</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1315B</td>
<td>1200 Series Diode Array Detector</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1315C</td>
<td>1200 Series Diode Array Detector VL+</td>
<td>B.06.30</td>
</tr>
<tr>
<td>G1315D</td>
<td>1200 Series Diode Array Detector VL</td>
<td>B.06.30</td>
</tr>
</tbody>
</table>
## Instrument Connections

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Module Name</th>
<th>Minimum Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G1321A</td>
<td>1100 Series Fluorescence Detector (FLD)</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1321B</td>
<td>1260 Infinity Fluorescence Detector</td>
<td>A.06.32</td>
</tr>
<tr>
<td>G1321C</td>
<td>1260 Infinity Fluorescence Detector</td>
<td>A.06.54</td>
</tr>
<tr>
<td>G1362A</td>
<td>1260 Infinity Refractive Index Detector</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1365A</td>
<td>1100 Series Multiple Wavelength Detector</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1365B</td>
<td>1100 Series Multiple Wavelength Detector</td>
<td>A.06.10</td>
</tr>
<tr>
<td>G1365C</td>
<td>1260 Infinity Multiple Wavelength Detector</td>
<td>B.06.30</td>
</tr>
<tr>
<td>G1365D</td>
<td>1260 Infinity Multiple Wavelength Detector VL</td>
<td>B.06.30</td>
</tr>
<tr>
<td>G4212A</td>
<td>1290 Infinity Diode Array Detector</td>
<td>B.06.30</td>
</tr>
<tr>
<td>G4212B</td>
<td>1260 Infinity Diode Array Detector</td>
<td>B.06.30</td>
</tr>
<tr>
<td>HDR-DAD Cluster</td>
<td>2x G4212A, 2x G4212B, 2x G7117A or 2x G7117B, or a combination of either 1x G4212A and 1x G4212B, or 1x G7117A and 1x G7117B</td>
<td>B.06.57</td>
</tr>
<tr>
<td>G7114A</td>
<td>1260 Infinity II VWD</td>
<td>D.07.01</td>
</tr>
<tr>
<td>G7114B</td>
<td>1290 Infinity II Variable Wavelength Detector</td>
<td>D.06.70</td>
</tr>
<tr>
<td>G7115A</td>
<td>1260 Infinity II DAD WR</td>
<td>D.07.01</td>
</tr>
<tr>
<td>G7117A</td>
<td>1290 Infinity II Diode Array Detector</td>
<td>D.06.70</td>
</tr>
<tr>
<td>G7117B</td>
<td>1290 Infinity II Diode Array Detector FS</td>
<td>D.06.70</td>
</tr>
<tr>
<td>G7117C</td>
<td>1260 Infinity II DAD HS</td>
<td>D.07.01</td>
</tr>
<tr>
<td>G7121A</td>
<td>1260 Infinity II FLD</td>
<td>D.07.01</td>
</tr>
<tr>
<td>G7121B</td>
<td>1260 Infinity II FLD Spectra</td>
<td>D.07.01</td>
</tr>
<tr>
<td>G7162A</td>
<td>1260 Infinity II Refractive Index Detector</td>
<td>D.06.76</td>
</tr>
<tr>
<td>G7162B</td>
<td>1290 Infinity II Refractive Index Detector</td>
<td>D.06.76</td>
</tr>
<tr>
<td>G7165A</td>
<td>1260 Infinity II MWD</td>
<td>D.07.01</td>
</tr>
</tbody>
</table>

**ELSD**

| G4260A         | 380-ELSD                                              | 25.00                     |
## Appendix

### Instrument Connections

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Module Name</th>
<th>Minimum Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G4261A</td>
<td>385-ELSD</td>
<td>25.00</td>
</tr>
<tr>
<td>G4260B</td>
<td>1260 Infinity ELSD</td>
<td>31.06</td>
</tr>
<tr>
<td>G4261B</td>
<td>1290 Infinity ELSD</td>
<td>31.06</td>
</tr>
<tr>
<td>G7102A</td>
<td>1290 Infinity II ELSD</td>
<td>31.06</td>
</tr>
</tbody>
</table>

### Agilent LC – Valve Solutions

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Module Name</th>
<th>Minimum Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G1156A</td>
<td>1200 Series 6 Position / 7 Port Valve (400 bar)</td>
<td>A.06.02</td>
</tr>
<tr>
<td>G1157A</td>
<td>1200 Series 2 Position / 10 Port Valve</td>
<td>A.06.02</td>
</tr>
<tr>
<td>G1158A</td>
<td>1200 Series 2 Position / 6 Port Valve</td>
<td>A.06.02</td>
</tr>
<tr>
<td>G1158B</td>
<td>1200 Series 2 Position / 6 Port Valve (600bar)</td>
<td>A.06.02</td>
</tr>
<tr>
<td>G1159A</td>
<td>1200 Series 6 Position Selection Valve</td>
<td>A.06.02</td>
</tr>
<tr>
<td>G1160A</td>
<td>1100 Series Multiple Purpose Switching Valve (12 Position / 13 Port)</td>
<td>A.06.02</td>
</tr>
<tr>
<td>G1162A</td>
<td>1200 Series 2 Position/ 6 Port Micro Valve</td>
<td>A.06.02</td>
</tr>
<tr>
<td>G1163A</td>
<td>1200 Series 2 Position/ 10 Port Micro Valve</td>
<td>A.06.02</td>
</tr>
<tr>
<td>G1170A</td>
<td>1290 Infinity Valve Drive</td>
<td>B.06.40</td>
</tr>
<tr>
<td>G4227A</td>
<td>1290 Infinity Flexible Cube</td>
<td>B.06.52</td>
</tr>
<tr>
<td>G1390B</td>
<td>UIB II</td>
<td>B.06.53</td>
</tr>
</tbody>
</table>

¹ A host may be required. For details see latest driver release note.
### Agilent LC Systems

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Module Name</th>
<th>Minimum Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G4286A</td>
<td>1120 Compact LC, Isocratic</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4286B</td>
<td>1220 Infinity LC System Isocratic, Man. Inj., VWD, 600 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4287A</td>
<td>1120 Compact LC, Isocratic with Oven and ALS</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4287B</td>
<td>1220 Infinity LC Isocratic, ALS, TCC, VWD, 600 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4288A</td>
<td>1120 Compact LC, Gradient</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4288B</td>
<td>1220 Infinity LC Gradient, Man. Inj., VWD, 600 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4289A</td>
<td>1120 Compact LC, Gradient with Oven</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4289B</td>
<td>1220 Infinity LC Gradient, ALS, TCC, VWD, 600 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4290A</td>
<td>1120 Compact LC, Gradient with oven and ALS</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4290B</td>
<td>1220 Infinity LC Gradient, ALS, Man. Inj., TCC, VWD, 600 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4291B</td>
<td>1220 Infinity LC Isocratic, Man. Inj., TCC, VWD, 600 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4292B</td>
<td>1220 Infinity LC Isocratic, ALS, VWD, 600 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4293B</td>
<td>1220 Infinity LC Gradient, ALS, VWD, 600 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4294B</td>
<td>1220 Infinity LC Gradient, ALS, TCC, DAD, 600 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4286C</td>
<td>1220 Infinity LC System VL, Isocratic, Man. Inj., VWD, 400 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4287C</td>
<td>S1220 Infinity LC System VL, Isocratic, ALS, TCC, VWD, 400 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4288C</td>
<td>1220 Infinity LC System VL, Gradient, Man. Inj. VWD, 400 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4289C</td>
<td>1220 Infinity LC System VL, Gradient, Man. Inj. VWD, 400 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4290C</td>
<td>1220 Infinity LC System VL, Gradient, ALS, TCC, VWD, 400 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4291C</td>
<td>1220 Infinity LC System VL, Isocratic, Man. Inj. TCC, VWD, 400 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4292C</td>
<td>1220 Infinity LC System VL, Isocratic, ALS, VWD, 400 bar</td>
<td>B.06.50</td>
</tr>
<tr>
<td>G4293C</td>
<td>1220 Infinity LC System VL, Gradient, ALS, VWD, 400 bar</td>
<td>B.06.50</td>
</tr>
</tbody>
</table>
Agilent LC/MS

Recommended Firmware

Always use the most recent Firmware installation package that comes with the driver package.

Agilent LC/MS Single Quad 6100 Series

The following Agilent LC/MS instruments can be controlled with OpenLAB CDS.

<table>
<thead>
<tr>
<th>Product number</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>G6120C</td>
<td>MS Modules</td>
<td>6120B and 6130B systems need to be upgraded to 'C' via upgrade product (G2735N)</td>
</tr>
<tr>
<td>G6130C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>G1947B</td>
<td>APCI</td>
<td>ESI or AJS capable source required</td>
</tr>
<tr>
<td>G1971B</td>
<td>APPI (Photo Ionization)</td>
<td></td>
</tr>
<tr>
<td>G1948B</td>
<td>ESI</td>
<td></td>
</tr>
<tr>
<td>G1978B</td>
<td>Multimode Source</td>
<td></td>
</tr>
<tr>
<td>G1958B</td>
<td>Agilent Jet Stream for Single Quad</td>
<td></td>
</tr>
<tr>
<td>G1951A</td>
<td>Analog Output Accessory</td>
<td></td>
</tr>
</tbody>
</table>
Agilent GC and GC/MS

Agilent GC

Recommended Firmware

Agilent recommends using the latest firmware revision in order to provide the highest level of system capability.

The tables below list the firmware used during the last software tests. Upgrading firmware to this version is not required in all cases. A firmware upgrade should be done if you face problems or want to add system capability to your GC. Refer to latest Hardware Service Notes for latest firmware available.

### Supported GC Systems

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Description</th>
<th>Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G3440A</td>
<td>7890A</td>
<td>A.01.16</td>
</tr>
<tr>
<td>G3445A</td>
<td>7890A</td>
<td>A.01.16</td>
</tr>
<tr>
<td>G3440B</td>
<td>7890B</td>
<td>B.02.04.2</td>
</tr>
<tr>
<td>G3445B</td>
<td>7890B</td>
<td>B.02.04.2</td>
</tr>
<tr>
<td>G4350A</td>
<td>7820A</td>
<td>A.01.17.004</td>
</tr>
<tr>
<td>G1530N</td>
<td>6890N</td>
<td>N.06.07</td>
</tr>
<tr>
<td>G1540N</td>
<td>6890N</td>
<td>N.06.07</td>
</tr>
<tr>
<td>G1530A</td>
<td>6890A</td>
<td>A.03.08</td>
</tr>
<tr>
<td>G1540A</td>
<td>6890A</td>
<td>A.03.08</td>
</tr>
<tr>
<td>G1540A</td>
<td>6890Plus</td>
<td>A.03.08</td>
</tr>
<tr>
<td>G2630A</td>
<td>6850 Handheld Controller</td>
<td>A.06.02</td>
</tr>
<tr>
<td></td>
<td>Serial # &gt;= US10243001</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Serial # &lt; US00003200</td>
<td>A.03.07</td>
</tr>
<tr>
<td>G3581A</td>
<td>490 Micro GC</td>
<td>3.32</td>
</tr>
</tbody>
</table>
### Instrument Connections

#### Supported Autosamplers

**Table 10**  Agilent GC Autosampler

<table>
<thead>
<tr>
<th>Model number</th>
<th>Description</th>
<th>Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G3420A</td>
<td>7693 ALS Controller</td>
<td>A.02.16</td>
</tr>
<tr>
<td>G4513A</td>
<td>7693 Injector</td>
<td>A.10.09</td>
</tr>
<tr>
<td>G4514A</td>
<td>Tray</td>
<td>A.10.16</td>
</tr>
<tr>
<td>G4515A</td>
<td>BCR/Mixer</td>
<td>A.10.05</td>
</tr>
<tr>
<td>G4516A</td>
<td>External Controller for 68xx</td>
<td>A.01.07</td>
</tr>
<tr>
<td>G4517A</td>
<td>6890 Plus Card Upgrade</td>
<td>A.01.07</td>
</tr>
<tr>
<td>G4520A</td>
<td>Tray with BCR/Mixer</td>
<td></td>
</tr>
<tr>
<td>G2912A</td>
<td>7683 ALS Controller</td>
<td>A.02.01</td>
</tr>
<tr>
<td>G2613A</td>
<td>7683A Injector</td>
<td>A.10.07</td>
</tr>
<tr>
<td>G2913A</td>
<td>7683B Injector</td>
<td>A.11.03</td>
</tr>
<tr>
<td>G2614A</td>
<td>Tray</td>
<td>A.02.01</td>
</tr>
<tr>
<td>G2615A</td>
<td>BCR/Mixer</td>
<td>n/a</td>
</tr>
<tr>
<td>G4567A</td>
<td>7650A ALS Injector</td>
<td>A.10.02</td>
</tr>
<tr>
<td>G2880A</td>
<td>6850 ALS Injector</td>
<td>A.10.05</td>
</tr>
</tbody>
</table>

**Table 11**  Agilent Headspace Autosampler

<table>
<thead>
<tr>
<th>Product number</th>
<th>Description</th>
<th>Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G4556A</td>
<td>7697A Headspace</td>
<td>A.01.07.1</td>
</tr>
<tr>
<td>G4557A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>G1888A</td>
<td>G1888 Headspace</td>
<td>A.01.10</td>
</tr>
</tbody>
</table>
### Table 12  Agilent CTC and PAL-xt CTC Sampler with Agilent GC

<table>
<thead>
<tr>
<th>Product number</th>
<th>Description</th>
<th>Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G6500-CTC</td>
<td>CTC Combi-Pal for Liquid and Headspace Injection</td>
<td>Agilent 2.6.8 or 4.3.0</td>
</tr>
<tr>
<td>G6501-CTC</td>
<td>CTC Combi-Pal for Liquid Injection</td>
<td>Agilent 2.6.8 or 4.3.0</td>
</tr>
<tr>
<td>G6509-CTC</td>
<td>CTC Combi-Pal for Liquid Injection</td>
<td>Agilent 2.6.8 or 4.3.0</td>
</tr>
<tr>
<td>G6502-CTC</td>
<td>CTC GC-Pal for Liquid Injection</td>
<td>Agilent 2.6.8 or 4.3.0</td>
</tr>
<tr>
<td>G6501B</td>
<td>Agilent GC Sampler 80 for Liquid Injection</td>
<td>4.3.0</td>
</tr>
<tr>
<td>G6502B</td>
<td>Agilent GC Injector 80 for Liquid Injection</td>
<td>4.3.0</td>
</tr>
<tr>
<td>G6509B</td>
<td>Agilent GC Sampler 120 for Liquid Injection</td>
<td>4.3.0</td>
</tr>
</tbody>
</table>

### Table 13  Agilent CTC PAL-3 Autosampler with Agilent GC

<table>
<thead>
<tr>
<th>Product number</th>
<th>Description</th>
<th>Firmware Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>G7366A</td>
<td>PAL RTC 120 Robotic Tool Change X-rail</td>
<td>2.2.3</td>
</tr>
<tr>
<td>G9256AA</td>
<td>PAL RSI 120 Robotic Sample Injection X-rail</td>
<td>2.2.3</td>
</tr>
<tr>
<td>G7368A</td>
<td>PAL RSI 53 Robotic Sample Injection X-rail</td>
<td>2.2.3</td>
</tr>
<tr>
<td>G7370A</td>
<td>PAL LSI 53 Liquid Sample Injection X-rail</td>
<td>2.2.3</td>
</tr>
</tbody>
</table>
## Agilent GC/MS

### Recommended Firmware

Always use the most recent MS Firmware installation package that comes with the driver package.

### Agilent GC/MS Single Quad Series

The following GC/MS Models can be controlled with OpenLAB CDS.

<table>
<thead>
<tr>
<th>Model number / series</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>5975A</td>
<td>MS System</td>
<td>EI only</td>
</tr>
<tr>
<td>5975B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5975C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5975E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5977A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5977E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5977B</td>
<td></td>
<td>HES supported for 5977B</td>
</tr>
<tr>
<td>7890A</td>
<td>GC System</td>
<td>GC's supported as part of</td>
</tr>
<tr>
<td>7890B</td>
<td></td>
<td>GC/MS system - see &quot;Supported GC Systems&quot; on</td>
</tr>
<tr>
<td>7820</td>
<td></td>
<td>page 131 for details</td>
</tr>
<tr>
<td>6890N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6850</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7693</td>
<td>GC ALS</td>
<td>Samplers supported as part of</td>
</tr>
<tr>
<td>7683B</td>
<td></td>
<td>GC/MS system - see &quot;Supported Autosamplers&quot; on</td>
</tr>
<tr>
<td>7650</td>
<td></td>
<td>page 132 for details</td>
</tr>
<tr>
<td>PAL-XT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PAL-3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>G7697A</td>
<td>Headspace</td>
<td></td>
</tr>
<tr>
<td>G1888</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Other supported Agilent Instruments

Other Agilent instruments or modules that you can connect with the latest revision of OpenLAB CDS:

**Table 14** Other Agilent modules

<table>
<thead>
<tr>
<th>Product number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>35900E</td>
<td>35900 A/D Interface</td>
</tr>
<tr>
<td>35900E (Series II)</td>
<td></td>
</tr>
<tr>
<td>SS420x</td>
<td>A/D Interface</td>
</tr>
<tr>
<td>7667A</td>
<td>Mini Thermal Desorber</td>
</tr>
</tbody>
</table>
Third Party Instruments

The following Non-Agilent Instruments can be controlled with OpenLAB CDS 2.1.

**NOTE**
Download the most recent instrument drivers available from SubscribeNet to control non-Agilent Instruments.

### Table 15  Third Party Drivers compatible with OpenLAB CDS 2.1

<table>
<thead>
<tr>
<th>3rd Party Vendor</th>
<th>Driver Type</th>
<th>Instrument Name</th>
<th>Driver Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scion / Bruker/ Varian</td>
<td>GC</td>
<td>430/436, 450/456, CP3800, CP3900, and associated Auto-samplers</td>
<td>A.02.02</td>
</tr>
<tr>
<td>Shimadzu</td>
<td>LC</td>
<td>LC-20 (Prominence), LC-30 (Nexera), LC-2030 (Prominence-i), LC-2040 (Nexera-i), SPD-M20A/SPD-M30A</td>
<td>Expected availability within 2016 ¹</td>
</tr>
<tr>
<td>Valco Instruments Co. Inc. (VICI)</td>
<td>Valve</td>
<td>EMHCA-CE (High Speed), EMHA-C (Two Position), EMTCA-C (High Torque)</td>
<td>A.01.01</td>
</tr>
<tr>
<td>Waters</td>
<td>LC</td>
<td>Acquity and Acquity H-Class</td>
<td>A.1.2</td>
</tr>
<tr>
<td>Waters</td>
<td>LC</td>
<td>Alliance and e-Alliance</td>
<td>Expected availability within 2016 ¹</td>
</tr>
</tbody>
</table>

¹ For further information, please contact your local Agilent Sales representative
Incompatible Instruments and Modules

The following tables summarize selected instruments or modules that can not be controlled with the current revision of OpenLAB CDS.

Incompatible LC and LC/MS Modules

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Module Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>G1364A-D</td>
<td>Fraction Collector / Fraction Cluster</td>
</tr>
<tr>
<td>G5664A</td>
<td>Bio-inert Fraction Collector</td>
</tr>
<tr>
<td>G1377A</td>
<td>High Performance Micro Autosampler</td>
</tr>
<tr>
<td>G1389A</td>
<td>Micro Thermostatted Autosampler</td>
</tr>
<tr>
<td>G2258A</td>
<td>Dual-Loop Autosampler</td>
</tr>
<tr>
<td>G2260A</td>
<td>Preparative Autosampler (High flow)</td>
</tr>
<tr>
<td>G7157A</td>
<td>1260 Infinity II Prep Sampler</td>
</tr>
<tr>
<td>G1376A</td>
<td>Capillary Pump</td>
</tr>
<tr>
<td>G2226A</td>
<td>Nanoflow Pump</td>
</tr>
<tr>
<td>G1361A</td>
<td>Preparative Pump</td>
</tr>
<tr>
<td>G4218A</td>
<td>Evaporative Light Scattering Detector</td>
</tr>
<tr>
<td>G1390A</td>
<td>UIB</td>
</tr>
<tr>
<td>G4240A</td>
<td>1200 Chip Cube</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>G6120B</th>
<th>LC/MS Single Quad modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>G6130B</td>
<td>6120B and 6130B systems can be upgraded to 'C' via upgrade product (G2735N)</td>
</tr>
</tbody>
</table>

Incompatible CE Instruments

OpenLAB CDS 2.1 can not be used to control CE Instruments.
## Incompatible GC and GC/MS Instruments

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Instrument Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>n/a</td>
<td>5890A GC system</td>
</tr>
<tr>
<td>4890D</td>
<td>5890 Series II GC system</td>
</tr>
<tr>
<td>G1176A</td>
<td>6820 GC system</td>
</tr>
<tr>
<td>G1180A</td>
<td>6820 GC system</td>
</tr>
<tr>
<td>G2629A</td>
<td>6850 Handheld Controller</td>
</tr>
<tr>
<td>G3581A</td>
<td>3000 Micro GC, M200, M400</td>
</tr>
<tr>
<td>19405A/B</td>
<td>Sampler Event Control Module (SECM)</td>
</tr>
<tr>
<td>18593A</td>
<td>7673A GC Autosampler family</td>
</tr>
<tr>
<td>18594A</td>
<td>7673A GC Autosampler family</td>
</tr>
<tr>
<td>18596A</td>
<td>7673A GC Autosampler family</td>
</tr>
<tr>
<td>18593B</td>
<td>7673B GC Autosampler family</td>
</tr>
<tr>
<td>18594B</td>
<td>7673B GC Autosampler family</td>
</tr>
<tr>
<td>18596B</td>
<td>7673B GC Autosampler family</td>
</tr>
<tr>
<td>G1512A</td>
<td>7673C GC Autosampler family</td>
</tr>
<tr>
<td>G1513A</td>
<td>7673C GC Autosampler family</td>
</tr>
<tr>
<td>18596C</td>
<td>7673C GC Autosampler family</td>
</tr>
<tr>
<td>7694A</td>
<td>Headspace</td>
</tr>
<tr>
<td>G1289A</td>
<td>Headspace</td>
</tr>
<tr>
<td>G1290A</td>
<td>Headspace</td>
</tr>
<tr>
<td>G1883A</td>
<td>Headspace</td>
</tr>
<tr>
<td>G8130A</td>
<td>Workbench Tray</td>
</tr>
<tr>
<td>G7361A</td>
<td>Archon Purge and Trap Auto sampler for Needle Sparge</td>
</tr>
<tr>
<td>G7360A</td>
<td>Archon Purge and Trap Auto sampler for Water only</td>
</tr>
<tr>
<td>G5975T</td>
<td>Integrated GC/MS</td>
</tr>
<tr>
<td>G1926A</td>
<td>Barcode Reader</td>
</tr>
<tr>
<td>G4557A</td>
<td>Barcode Reader for 111 vial, not supported on 12 vial</td>
</tr>
<tr>
<td>G2403A</td>
<td>LAN/RS232 converter Dudley box</td>
</tr>
<tr>
<td>G2629A</td>
<td>6850 Handheld Controller</td>
</tr>
</tbody>
</table>
Privileges in the Control Panel

The privileges described in the following can be associated with different roles in the Control Panel. The following roles are available:

- Everything
- Instrument User
- System Administrator
- Technician
- Instrument Administrator
- Chemist
- Project Administrator

In the Control Panel under Administration > Roles, you can view or change the associated privileges, or create your own roles.

Project Privileges

**Table 16  Acquisition Method**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and modify acquisition method</td>
<td>Create, edit and save an acquisition method file (*.amx)</td>
</tr>
</tbody>
</table>

**Table 17  Audit Trail**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change method audit trail settings</td>
<td>Edit and save method audit trail settings (project properties in the Control Panel).</td>
</tr>
<tr>
<td>Review audit trail</td>
<td>Confirm that you reviewed a changed audit trail.</td>
</tr>
<tr>
<td>Add manual audit trail entry</td>
<td>Add a manual entry to document your own actions in the audit trail.</td>
</tr>
</tbody>
</table>
### Appendix
Privileges in the Control Panel

#### Table 18 Control

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort any running sample</td>
<td>Abort any running sequence or single run.</td>
</tr>
<tr>
<td>Manual control (in run)</td>
<td>Access manual control functions while the instrument is running.</td>
</tr>
<tr>
<td>Manual control (only when instrument idle)</td>
<td>Access manual control functions while the instrument is idle.</td>
</tr>
<tr>
<td>MS autotune and manual tuning</td>
<td>Access all MS tune and maintenance functionality, including manual tune, autotune, and check tune.</td>
</tr>
<tr>
<td>MS autotune</td>
<td>Perform MS autotune and check tune.</td>
</tr>
</tbody>
</table>

#### Table 19 Custom Tools

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Custom Tools section</td>
<td>Start external programs that were added to the application via the customization tool</td>
</tr>
</tbody>
</table>

#### Table 20 Data

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export data</td>
<td>Export data into an OpenLAB archive (*.olax).</td>
</tr>
<tr>
<td>Import data</td>
<td>Import data from OpenLAB archives (*.olax) into the OpenLAB system.</td>
</tr>
<tr>
<td>Save reports to disk</td>
<td>Save or export a report to a location on a disk or network share.</td>
</tr>
</tbody>
</table>
## Table 21  Data Processing

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reprocess data</td>
<td>Reprocess injections or result sets.</td>
</tr>
<tr>
<td>Do manual compound identification</td>
<td>Manually assign a compound to a peak.</td>
</tr>
<tr>
<td>Do manual integration</td>
<td>Activate manual integration in the Chromatograms window.</td>
</tr>
<tr>
<td>Update master processing method</td>
<td>Save changes from a result set method to the corresponding master processing method in the Methods folder.</td>
</tr>
<tr>
<td>Create new result set</td>
<td>Combine single samples or sequences from different sources in a new, self-assembled result set.</td>
</tr>
<tr>
<td>Print results reports</td>
<td>Create reports for your methods or results.</td>
</tr>
<tr>
<td>Launch Custom Calculation Editor</td>
<td>Start the Custom Calculation Editor from Data Analysis.</td>
</tr>
</tbody>
</table>

## Table 22  E-Signature

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Signature Sign Data Files</td>
<td>User can sign data files</td>
</tr>
<tr>
<td>Revoke E-Signature</td>
<td>User can revoke the e-signature.</td>
</tr>
</tbody>
</table>

## Table 23  File and Folder Operations

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete report templates</td>
<td>Delete report templates (*.rdl) in the Data Selection view of Data Analysis.</td>
</tr>
<tr>
<td>Delete sequence templates</td>
<td>Delete sequence templates (*.stx) files in the Data Selection view of Data Analysis.</td>
</tr>
<tr>
<td>Delete methods</td>
<td>Delete processing methods (<em>.pmx) or acquisition methods (</em>.amx) in the Data Selection view of Data Analysis.</td>
</tr>
</tbody>
</table>
# Appendix

Privileges in the Control Panel

## Table 24  Lock

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock Results</td>
<td>Lock a result set to protect it from being changed.</td>
</tr>
<tr>
<td>Unlock Results</td>
<td>Unlock a locked result set.</td>
</tr>
</tbody>
</table>

## Table 25  Processing Method

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit calibration parameters</td>
<td>View and edit the parameters in the <strong>Compounds &gt; Calibration</strong> section of method.</td>
</tr>
<tr>
<td>Edit spectra parameters</td>
<td>View and edit the parameters in the <strong>Compounds &gt; Spectra</strong> section of method.</td>
</tr>
<tr>
<td>Edit system suitability parameters</td>
<td>View and edit the parameters in the <strong>Compounds &gt; System Suitability</strong> section of method.</td>
</tr>
<tr>
<td>Create processing method</td>
<td>Create a new processing method (*.pmx), or save a method under a new name.</td>
</tr>
<tr>
<td>Save master method</td>
<td>Save changes to a processing method in the Methods folder.</td>
</tr>
<tr>
<td>Save result set method</td>
<td>Save changes to a processing method in the result set folder.</td>
</tr>
<tr>
<td>Edit custom calculation parameters</td>
<td>View and edit the parameters in the <strong>Tools &gt; Custom Calculation</strong> section of a method.</td>
</tr>
<tr>
<td>Edit sample information</td>
<td>Edit information in the <strong>Injection List</strong> window.</td>
</tr>
<tr>
<td>Edit integration parameters</td>
<td>View and edit the parameters in the <strong>Integration Events</strong> section of a method.</td>
</tr>
<tr>
<td>Edit identification parameters</td>
<td>View and edit the parameters in the <strong>Compounds &gt; Identification</strong> section of a method.</td>
</tr>
<tr>
<td>Edit signal parameters</td>
<td>View and edit the parameters in the <strong>General &gt; Signals</strong> section of a method.</td>
</tr>
<tr>
<td>Edit sample purity parameters</td>
<td>View and edit the parameters in the <strong>MS Sample Purity</strong> section of a method.</td>
</tr>
</tbody>
</table>
**Table 26  Project Management**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage project or project group</td>
<td>User can create or edit project properties and can move the project but cannot view or edit the project access settings.</td>
</tr>
<tr>
<td>Manage project or project group access</td>
<td>User can view and edit the project access settings.</td>
</tr>
</tbody>
</table>
| View project or project group     | User can see a project and project details but cannot edit.  
*Note:* This privilege is required for all users.                      |
| Access content using web client   | User can view the data via the Content Management web interface.                                                                                     |
| Edit content of project           | User can create new versions of documents (e.g. data, methods, or templates).                                                                 |

**Table 27  Report Template**

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlock/lock report template items</td>
<td>Lock and unlock report template items (tables, chromatograms, groups of items, ...) to control who is allowed to modify those.</td>
</tr>
<tr>
<td>Validate report template</td>
<td>Confirm usage of report templates that have been modified outside OpenLAB CDS.</td>
</tr>
<tr>
<td>Create report template</td>
<td>Create and edit report templates in the Reporting view.</td>
</tr>
</tbody>
</table>
## Appendix

### Privileges in the Control Panel

#### Table 28  Sample Prep

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and modify sample prep</td>
<td>View, edit, and save an autosampler sample prep file</td>
</tr>
</tbody>
</table>

#### Table 29  Sequence Template

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and modify sequence</td>
<td>Create, edit and save sequence creation templates (*.stx).</td>
</tr>
</tbody>
</table>

#### Table 30  Sequence

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit any users running sequence</td>
<td>Edit any user’s running sequence (status <strong>Acquiring</strong> in the Run Queue).</td>
</tr>
<tr>
<td>Create and modify sequence</td>
<td>Create, edit and save sequences (*.sqx)</td>
</tr>
<tr>
<td>Edit users own running sequences</td>
<td>Edit your own running sequences (status <strong>Acquiring</strong> in the Run Queue).</td>
</tr>
</tbody>
</table>
Instrument Privileges

**Table 31  Instrument Management**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View instrument or location</td>
<td>User can view and access a location in the tree, but not edit access security, can view properties.</td>
</tr>
<tr>
<td>Manage Instrument or location</td>
<td>User can create and move locations and edit properties (name, description, etc).</td>
</tr>
<tr>
<td>Manage instrument or location access</td>
<td>User can view and edit the location access settings.</td>
</tr>
<tr>
<td>Run instrument</td>
<td>User can start an instrument session.</td>
</tr>
<tr>
<td>Service instrument</td>
<td>User can lock or unlock an instrument (to service it).</td>
</tr>
</tbody>
</table>
### Administrative Privileges

#### Table 32  System Administration

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage printers</td>
<td>Can add/remove printers and print server.</td>
</tr>
<tr>
<td>Edit activity log properties</td>
<td>Can change the Activity log Settings in the Control Panel (that is, can turn logging on for the System Activity Log).</td>
</tr>
<tr>
<td>Create administrative reports</td>
<td>Can create any of the system admin reports.</td>
</tr>
<tr>
<td>Manage system components</td>
<td>Can install/remove components (applications).</td>
</tr>
<tr>
<td>Manage security</td>
<td>Can change security settings and assign security roles.</td>
</tr>
<tr>
<td></td>
<td>Can edit (add, change etc) users, groups and roles.</td>
</tr>
<tr>
<td></td>
<td>Can move and delete files and folders in the Content Management database.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> A user with this privilege can grant himself access to all settings in Shared Services. Be careful who you grant the Manage Security privilege.</td>
</tr>
<tr>
<td>Manage instrument controllers</td>
<td>Can edit Instrument Controllers in the Control Panel.</td>
</tr>
<tr>
<td>Unlock any locked UI</td>
<td>Can log in to another user’s locked session.</td>
</tr>
</tbody>
</table>
Sales and Support Assistance

Please check the following web site for your local sales and support contact:

In This Book

This document provides instructions for installation, configuration, administration, and maintenance of an OpenLAB CDS Workstation. It includes information on the license generation with SubscribeNet.

The manual describes the following:

- Install OpenLAB CDS Workstation with Local File System
- Generating and Downloading Your Software License
- Configure OpenLAB CDS Workstation
- Optional Procedures
- Customization
- About the OpenLAB CDS software
- System Setup and Maintenance